Microsoft Office v. X for Mac Resource Kit
Contents

What's New in Office v. X for Mac .................................................................8
    Office Shared Features .............................................................................8
    Microsoft Word X .....................................................................................9
    Microsoft Excel X ..................................................................................10
    Microsoft Entourage X .........................................................................11
    Microsoft PowerPoint X .........................................................................11
Licensing Office v. X for Mac ..................................................................12
Configuring Word X ..................................................................................13
    Setting the Default File Format for Word Documents .............................14
    Setting a Startup Folder Location ............................................................14
    Setting the Default Location for Word Templates .................................14
    Locating Word Components ..................................................................15
    Customizing Toolbars, Menus, and Shortcut Keys .................................16
    Using Add-ins in Word X ........................................................................17
    Configuring Word on a Computer with Multiple Users .......................17
    Using AppleScript ..................................................................................18
Configuring Excel X ..................................................................................18
    Setting the Default File Format for Excel Workbooks ............................19
    Setting the Default File Location for Excel Workbooks ..........................19
    Setting an Alternate Startup Folder ........................................................19
    Customizing Menus and Toolbars .........................................................20
    Creating Templates for Excel X ...............................................................20
    Using Add-ins with Excel X .................................................................22
    Using AppleScript ..................................................................................24
Configuring PowerPoint X ......................................................................24
Configuring Entourage X .........................................................................25
    Helping Users Configure Entourage .....................................................25
        Providing Setup Information to Users .................................................25
        Providing a Default Setup Folder to Users .......................................27
What's New in Office v. X for Mac

This part of the Microsoft® Office v. X Resource Kit for Mac discusses the new and updated features of each Office v. X application that are most relevant for administrators, information technology (IT) professionals, and support staff.

Office Shared Features

**Improved support for Macintosh standards** Office v. X has been updated to take advantage of Mac OS X features:

- Office v. X works properly with multiple user accounts in Mac OS X.
- File dialog boxes in Office v. X use Navigation Services dialog boxes, giving Office applications direct access to the features of the Navigation Services dialog boxes, including the system Recent Files and Favorites lists.
- Office applications now work with several new Mac OS X keyboard shortcuts that let users perform specific tasks more quickly — for example, press ⌘+M to quickly minimize the active window to the Dock.
- Office v. X applications comply fully with Mac OS X theme and appearance settings.
- Office v. X applications use Quartz technology to provide new image manipulation features, such as the ability to set a specific transparency percentage for any drawing or picture.

**Based on Recent** New to the Office v. X Project Gallery is the Based on Recent category. If users want to base new documents on ones they've already created, this is a convenient way for them to open a new document. The preview pane displays copies of up to 27 of the most recently used files — from each Office program installed on the computer. Each time users select a copy of a file from the Based on Recent category in the Project Gallery, they create a new document with the same text as the previous document.

**Tools on the Web** Office Tools on the Web offers electronic services from the Microsoft Office Web site, such as additional templates and reference services. Users can access Tools on the Web by clicking **Tools on the Web** on the **Tools** menu in any Office v. X program.

**REALbasic Integration** REALbasic is a tool for creating Visual Basic applications. It has a fully integrated visual development and debugging environment. Developers can copy and paste BASIC code from the Microsoft Visual Basic® for Applications editor to the REALbasic editor, making it easy to migrate. A trial version of REALbasic is located in the Value Pack. Entourage does not support the REALbasic editor.
Full-text search in Help  Users can perform full-text searches of the Help topics for each program. For best results during a full-text search of the Help topics, users should type a few words, rather than a complete sentence or question, in either the Office Assistant balloon or in the Help Viewer. For example, to find Help on how to use the List Manager, users should type List Manager, not how do I use the List Manager.

Office Clipboard  The Office Clipboard collects and stores objects from all of the Office v. X programs in one place, and allows users to paste them when they need them. Users can paste selected clippings, or they can paste them all at once by clicking one button. Users can store up to 60 items or 16 MB of data on the Office Clipboard. Entourage does not support the Office Clipboard.

Improved cross-version and cross-platform support  Office v. X includes the following enhancements to ensure that your users can work with people using other versions of Office:


- An Office v. X document can be viewed in Office 98 or Office 2001 without losing formatting or data specific to Office v. X. Formatting or other features that are not supported in earlier versions of Office will not be available, but will reappear when the document is reopened in an Office v. X application.

- Office v. X documents that users revise and save by using earlier versions of Office applications do not retain features that are available only in Office v. X.

- Users can save Microsoft Word, Excel, and PowerPoint® X documents with three-letter filename extensions to improve compatibility with Windows applications.

- Office v. X includes additional TrueType fonts to match the fonts included with Office XP for Windows.

Microsoft Word X

Multi-selection  In Microsoft Word X for Mac, users can select multiple items in paragraphs, lists, or table cells that aren't next to each other by selecting the first item, holding down the ⌘ key, and selecting any additional items. Users can also use Multi-selection when finding and replacing text or formatting.

Clear Formatting  Users can use Clear Formatting to quickly remove and reset formatting for specific characters and paragraphs. Clear Formatting removes any manually-applied character and paragraph formatting, and resets the default text style.
Data Merge Manager  The Data Merge Manager helps users create form letters, labels, envelopes, catalogs, and other documents they want to share with others within one simplified window. If users use the Office Address Book as their data source, Word X allows users to select only the contacts they want to include in the data merge. Users can also use the Data Merge Manager to select specific contacts from the Office Address Book, and to send form letters as e-mail messages.

Office Address Book and Contact toolbar  Word X provides several new integration features with Microsoft Entourage™. Users can use the Contact toolbar to add or manage their contacts in the Office Address Book, and to insert contact information directly into documents. Users can also use the Office Address Book as their data source for sending out (or e-mailing) information using the new Data Merge Manager in Word.

Printing  Word X provides support for more European and Japanese envelope and mailing label sizes, support for more Unicode printer drivers, and support for printing to a Portable Document Format (PDF) file.

AppleWorks  Users can open word processing documents created in AppleWorks 5, AppleWorks 6, and AppleWorks 6 Japanese in Word X by using the built-in AppleWorks Converter.

Microsoft Excel X

AutoRecover  Microsoft Excel X recovers unsaved changes to documents if the program stops responding or there is a power failure. When AutoRecover is turned on, any changes that were made are saved at set intervals in a separate, temporary recovery file. Then, if the user has to restart Excel or their computer without saving their work, Excel automatically opens the recovery file. The recovery file contains the changes up until the last time AutoRecover saved the document. For example, if AutoRecover is set to save every five minutes, the user should not lose more than five minutes of work.

Customizable Keyboard Shortcuts  Users can customize keyboard shortcuts in Excel by assigning keyboard shortcuts to commands that do not already have them or by removing keyboard shortcuts they don't want. The only keyboard shortcuts that cannot be assigned to commands are shortcuts that are reserved by Mac OS X, such as ⌘+M and ⌘+H. Changes can be reset to the default keyboard shortcut settings at any time.
Microsoft Entourage X

**Performance enhancements**  In Microsoft Entourage X, data storage has been enhanced in a number of ways. If users are managing a large volume of messages, contacts, or other items in their Entourage folders, they should notice significantly improved performance.

**Internet standards support**  Entourage provides support for Internet mail, news, directory, and calendar standards, including POP, IMAP, NNTP, LDAP, vCard, and iCalendar. Users can exchange rich information by using HTML-formatted e-mail messages, share contact information with vCards, and invite others — including Microsoft Outlook users — to events by using iCalendar invitations.

**Insert rich content**  Entourage now supports rich content in messages, signatures, and notes. Pasted text — including fonts, font colors and sizes, bulleted lists, numbering, and alignment — retains the formatting options selected in the original document. Charts, tables, or other graphical elements can also be pasted into Entourage items as pictures.

**Mac OS Keychain support**  Entourage supports storage of account passwords in Mac OS Keychains.

**International address formats**  The Address Book can store addresses in the correct format for many different countries/regions. Users can also use a single address format for most contacts and then apply a specific format to individual contacts as they create them. If the Address Book doesn't have the address format they need, users can create a custom address format to use instead.

**Time-zone support in the Calendar**  If a user changes time zones, Entourage adjusts the events in the Calendar accordingly.

Microsoft PowerPoint X

**PowerPoint Packages**  The new PowerPoint Package option in Microsoft PowerPoint X gives users the ability to pack their presentation and all linked files into one folder so they can move the folder to a network share, put it on a disk, or burn it to a CD without losing any of the linked pictures, sounds, movies, hyperlinks, or other files.

**PowerPoint Movies**  PowerPoint Point X includes improvements in PowerPoint Movies, which are presentations saved as QuickTime movies. PowerPoint Movies now provide a higher level of fidelity to the original presentation. For example, movies can now include any combination of animations, slide transitions, and interactive features such as action buttons and hyperlinks.
**QuickTime transitions**  With full support for Apple QuickTime, PowerPoint can use QuickTime transitions to move between slides in a presentation.

**Multiple slide masters**  Like PowerPoint 2001, PowerPoint X supports the use of more than one slide master and title master in a presentation. Users can apply slide masters and title masters to single slides or multiple slides at a time, and if users need to copy slides from one presentation to another, they can set PowerPoint to copy the slide and title masters along with the slides.

**Slide Navigator**  During a slide show, users can easily find specific slides in their presentation by moving the scroll box on the Slide Navigator scroll bar and viewing the thumbnails. To activate Slide Navigator, users can click the **View** tab in the Preferences dialog box (**PowerPoint** menu, **Preferences** command), and then on the pop-up menu under **Slide Show**, click **Slide Navigator**.

---

**Licensing Office v. X for Mac**

As outlined in the Microsoft Office End-User License Agreement, users can install and use one copy of Microsoft Office v. X on a single computer. If a user is the primary user of that computer, he or she can also install a second copy of Office, for their exclusive use, on a portable computer, as long as that computer is not connected to the same network as the computer with the primary copy.

**Note**  If users install the same copy of Office v. X on more than one computer and exceed the number of installations permitted by your organization's license agreement, the Office programs will automatically quit shortly after being started. Before quitting, the user will have an opportunity to save changes that they have made to any open documents.

To install Office v. X on additional computers, your organization can purchase additional copies of Office through your Microsoft reseller, or purchase a volume license through the Microsoft Volume Licensing program.

- **Retail purchase**  If your organization needs less than five copies of Office, purchase each copy through your Microsoft reseller.

- **Volume licenses**  By participating in the Microsoft Volume Licensing program, you can purchase a volume license for five or more copies of Office. For information about this program, visit the **Microsoft Licensing Web site** at [http://www.microsoft.com/licensing/](http://www.microsoft.com/licensing/).

To determine which licensing option best meets your needs or to purchase a volume license, contact your Microsoft reseller. If you do not yet have a relationship with a Microsoft reseller, the Microsoft office for your region can help you find one. For information about contacting your regional Microsoft office, visit the **Microsoft Worldwide Information Web site** at [http://www.microsoft.com/worldwide/](http://www.microsoft.com/worldwide/).
Configuring Word X

As you are configuring Microsoft® Word X for Mac, it is helpful to keep in mind that the structure of Word consists of three layers: the application itself, templates, and documents. The application and template layers affect Word documents in different ways. The application provides the standard menus, commands, and toolbars. Templates serve a dual purpose: They provide a model for creating new documents and also act as a storage container for styles, macros, AutoText entries, and customized commands and toolbar settings. The document file contains the text, graphics, formatting, and settings such as margins and page layout for that particular document.

If you are deploying Word X across your organization from a network installation point you can set the preferences Word X uses so that each user has the same set of options and settings. For example, if your organization uses a set of common templates, you can store them in one location on a shared network folder and specify that location in Word.

The first time each user runs Word X, several preferences files are created to store default settings such as the file format and save location. These preference settings are saved in the Word Settings (10) and Microsoft Office Settings (10) files in the Users/username/Library/Preferences/Microsoft folder.

Below are some examples of preferences you can set for Word. After you configure Word with the default settings that you want, copy the Word Settings (10) and Microsoft Office Settings (10) files to each user's Users/username/Library/Preferences/Microsoft folder.

For more information about deploying Office v. X, see Deploying Office v. X for Mac on page 42.
Setting the Default File Format for Word Documents

You can set the default file format that Word uses to save documents. When you specify a default file format, members of your workgroup will automatically save their documents in that format.

Set the default file format for Word documents
1. On the Word menu, click Preferences, and then click Save.
2. On the Save Word files as pop-up menu, click the file format you want to use.
   All documents will be saved in the selected file format unless your users specify a different format in the Save dialog box (File menu, Save As command) when they save a document.

Setting a Startup Folder Location

When Word starts, it opens all documents and templates stored in the Startup folder. By default, the startup folder for Word is the Microsoft Office X/Office/Startup/Word folder. You can change the startup folder location in Word. For example, if you want Word to load global templates or documents that are stored on a network drive, you can change the startup folder location to point to that network drive.

Set a startup folder location
1. On the Word menu, click Preferences, and then click File Locations.
2. In the File types box, click Startup, and then click Modify.
3. Locate the folder you want to use as the startup folder, and then click Choose.
   Important Because Microsoft Word will attempt to open every file in the alternate startup folder, make sure you specify an empty folder or a folder that contains only files that Word can open. If the folder contains a file that Word cannot open, Word might stop responding. You can specify only one startup folder location for Word.

Setting the Default Location for Word Templates

Every Microsoft Word document is based on a template. A template determines the basic structure for a document and contains document settings such as AutoText entries, key assignments, macros, menus, page layout, special formatting, and styles. The two basic types of templates are global templates and document templates. Global templates, including the Normal template, contain settings that are available to all documents. Document templates, such as the memo or fax templates in the Project Gallery, contain settings that are available only to documents based on that template. For example, if you create a memo using a memo template, the memo can use the settings from the memo template as well as the settings in any global template.
You can set the default location for two types of templates: user templates and workgroup templates.

User templates are templates that are used by only a few users or that a user might want to customize (such as Normal, because it is always loaded globally) and are usually stored on the user's hard disk. By default, Word stores user templates in the Microsoft Office X/Templates folder on the user's computer.

Workgroup templates are templates that are needed by the entire workgroup or that users do not need to customize and are typically stored on a shared network drive. There is no initial default setting for workgroup templates.

When a user creates a new document, templates from both the User and the Workgroup templates folders are listed together in the Project Gallery (File menu, Project Gallery command).

Set the default location for Word templates

1. On the Word menu, click Preferences, and then click File Locations.
2. In the File types box, click either User templates or Workgroup templates, and then click Modify.
3. Locate the folder that contains the templates, and then click Choose.

Tip To make it easy for users to locate templates, you can create custom categories for templates in the Project Gallery by creating a new subfolder in the templates folder and then saving the templates in the subfolder. The name you give the subfolder appears as the new category.

If Word is set up on a computer with more than one user, see the Configuring Word on a Computer with Multiple Users on page 17 section for specific setup instructions.

Locating Word Components

The various components of Word — such as styles, macros, default page settings, AutoText entries, AutoCorrect entries, and custom command settings — are stored either in the document itself or in an attached template. Some components reside strictly in the document, others reside in a template, and still others can be stored in either the document or a template.

Of those components that reside in a template, some are always stored with the Normal template or the attached template, and others can be stored in a global template. Users can use the Organizer (Tools menu, Templates and Add-Ins command, Organizer button) to specify where AutoText entries, styles, custom toolbars, menus, and shortcut keys, and macros are stored. The following table shows where components can be stored.
<table>
<thead>
<tr>
<th>Component</th>
<th>Document</th>
<th>Normal or other template</th>
<th>Global templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoText entries</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Styles</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Custom toolbars, menus, and shortcut keys</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Macros</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Boilerplate text and graphics</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Default page settings</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Document text and graphics</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**Customizing Toolbars, Menus, and Shortcut Keys**

By customizing toolbars, menus, and shortcut keys, you can change Word to better suit the needs of your workgroup. For example, you can add frequently used commands and dialog box options to toolbars and menus, and remove items users rarely use. You can also customize shortcut key assignments by creating the shortcut keys that work best for your organization.

You can save custom toolbars, menus, and shortcut key settings in a template or in a document.

**Saving in a Template**

If you save the custom settings in a template, you can store them in the Normal template, an open template, or the template attached to the active document. To make customized settings available in any document, save the settings in the Normal template or in a template you plan to make global.

**Saving in a Document**

If you save the custom settings in a document, you can easily distribute the document and custom settings throughout your workgroup (through e-mail, for example). This ensures that the document and its custom settings cannot become separated.
Using Add-ins in Word X

Add-ins are supplemental programs that you install to extend the capabilities of Word by adding custom commands and specialized features. You can obtain add-ins from independent software vendors, or you can write your own custom add-in programs.

An add-in must be loaded into Word in the same way as a global template. Like a template, the add-in remains available as long as Word is running. To load automatically each time Word is started, the add-in must be stored in the Startup folder, the location of which is specified under File Locations on the Preferences dialog box (Word menu, Preferences command). By default, this location is the Microsoft Office X/Office/Startup/Word folder. For more information about loading and unloading add-ins, see Microsoft Word Help.

Configuring Word on a Computer with Multiple Users

When you install Microsoft Office v. X on a computer that does not already have a previous version of Office installed on it, a Normal template is created the first time you start Word. If the current user has Write privileges to the Microsoft Office X folder and the Templates subfolder, a Normal template is created in the Microsoft Office X/Templates folder. When you configure a computer running Word for multiple users, you must decide whether users should each have separate Normal templates, or should share the same Normal template.

If you want users to share the same Normal template, make sure all users have Read/Write privileges to the Microsoft Office X/Templates folder. Each user will then be able to access and make changes to the Normal template in the Microsoft Office X/Templates folder.

If you want each user to have his or her own Normal template, make sure no non-administrative users have Write privileges to the Microsoft Office X/Templates folder by changing user privileges.

Change user privileges

1. In the Finder, open the Applications folder, open the Microsoft Office X folder, select the Templates folder, and then click Show Info on the File menu.

2. Click Privileges on the pop-up menu, and then change the privileges of the Microsoft Office X folder to Everyone = Read Only.

After you change the user privileges, if automatic login is disabled, Word will automatically save a separate Normal template in the /Users/username/Library/Preferences/Microsoft folder for each user account that uses Word. If automatic login is enabled, non-administrative users will be prompted to select a new save location for any changes they make to the Normal template, and Word will automatically open the new Normal template the next time that user logs in and starts Word X.
If more than one user with administrative access uses the computer, those users will need to manually change their User Templates paths under User Information in Preferences to another location and copy the Normal template to that location to maintain separate Normal templates. Otherwise, all administrative accounts will share the Normal template in the Microsoft Office X/Templates folder.

Using AppleScript

The AppleScript scripting language can be used to automate tasks on Macintosh computers. To extend the functionality of Word or automate repetitive tasks, you can create your own AppleScript scripts or applets. You can then distribute these scripts to your users, or use a script to automate Office v. X deployment in your organization. For information about AppleScript, visit the Mactopia Developer Resources Web site at http://www.microsoft.com/mac/resources/resources_main.asp?EmbFName=devresources.asp.

Configuring Excel X

As you configure Microsoft Excel X for Mac for your organization, it is useful to understand the application's basic structure. Documents in Excel X are called workbooks. A workbook is a collection of worksheets, chart sheets, and Microsoft Visual Basic® for Applications (VBA) modules. The worksheet is the primary location for storing data in a workbook. Each worksheet can contain cells, which store data and formulas, and charts, which present data graphically. Each cell and chart item can have associated formatting, such as fonts, colors, and layout options.

If you are deploying Excel X across your organization from a network installation point you can set preferences in Excel X so that each user in the organization receives the same set of options and settings. For example, if the organization uses shared workbooks, you can specify the default file location where the workbooks are saved.

The first time each user runs Excel X, several preferences files are created to store default settings such as the file format and save location. These preferences settings are saved in the Excel Settings (10) and Microsoft Office Settings (10) files in the Users/username/Library/Preferences/Microsoft folder.

Below are some examples of preferences you can set for Excel. After you configure Excel with the default settings that you want, copy the Excel Settings (10) and Microsoft Office Settings (10) files to each user's Users/username/Library/Preferences/Microsoft folder.

For more information about deploying Office v. X, see Deploying Office v. X for Mac on page 42.
Setting the Default File Format for Excel Workbooks

If your organization uses more than one version of Excel, you can set the default file format that workbooks are saved in. When you specify a default file format, members of your workgroup can automatically save files in the best format for sharing within the workgroup.

Set the default file format for Excel workbooks

1. On the Excel menu, click Preferences, and then click Transition.
2. On the Default save as type pop-up menu, click the file format you want.
   All workbooks will be saved in the selected file format unless your users specify a different format in the Save dialog box (File menu, Save As command) when they save a workbook.

For more information about file formats and sharing files with other versions of Excel, see Converting Workbooks to Excel X from Earlier Versions of Excel on page 56.

Setting the Default File Location for Excel Workbooks

You can set the default file location for Excel workbooks to make it easier for users across the organization to share and collaborate on workbooks and files.

Set the default file location for Excel workbooks

1. On the Excel menu, click Preferences, and then click General.
2. In the Default file location box, type the path for the folder to use as the default file location.

Setting an Alternate Startup Folder

An alternate startup folder can be used in addition to the Microsoft Office X/Office/Startup/Excel folder. It can contain workbooks or other files your users want to open automatically when they start Microsoft Excel. The alternate startup folder can be a location on a shared network drive.

Excel opens files in the startup folder before opening files in the alternate startup folder. If a file in the alternate startup folder has the same name as a file in the startup folder, the file in the alternate startup folder is ignored.
Set an alternate startup folder

1. On the Excel menu, click Preferences, and then click General.

2. In the Alternate startup file location box, type the path for the folder to use as the alternate startup folder.

**Important** Because Microsoft Excel will attempt to open every file in the alternate startup folder, make sure you specify an empty folder or a folder that contains only files that Excel can open. If the folder contains a file that Excel cannot open, Excel might stop responding.

Customizing Menus and Toolbars

You can customize menus and toolbars by adding and removing commands and buttons. You can also create your own custom toolbars, hide or display toolbars, and move them. You can customize the menu bar in the same way that you customize any built-in toolbar — for example, you can add and remove menus — but you cannot hide the menu bar.

When you quit Excel, changes you made to the menu bar and built-in toolbars, any custom toolbars you created, and the toolbars currently displayed are saved in the Excel Toolbars (10) settings file in the Users/username/Library/Preferences/Microsoft folder. The toolbar configuration saved in this file is used by default each time Excel is started.

Toolbars you create or customize are available to all workbooks created using the same user account. To ensure that a custom toolbar is always available in a specific workbook regardless of user account, you can attach the toolbar to the workbook by clicking Attach on the Toolbars tab of the Customize dialog box (Tools menu, Customize command).

For more information about customizing menus and toolbars, see Microsoft Excel Help.

Creating Templates for Excel X

A template is a special workbook used as a pattern to create new workbooks. Excel X recognizes files that have the file type "sLS8" or the file extension .XLT as Excel templates.

To maintain consistency among workbooks, you can create templates for a workgroup. For example, you can create a sales report workbook, save it as a template, and distribute it to a workgroup. When users in the workgroup create weekly sales reports based on the Excel template, the template gives users a consistent set of menus, macros, and toolbars, as well as a consistent format.

To save a workbook as a template, click Save As on the File menu, and then click Template on the Format pop-up menu.
Storing workbook templates in the startup or alternate startup folder automatically makes the template available when users click **New (File menu)**. However, this increases the time Excel takes to start up. Alternatively, save templates in an appropriate folder in the Microsoft Office X/Templates folder to make it available from the **Project Gallery (File menu)**. New folders created in the Microsoft Office X/Templates folder will appear as new categories in the Project Gallery the next time users open it.

Settings saved in a template determine the following characteristics of new workbooks based on that template:

- Cell formats
- Custom menus, macros, and toolbars
- Number and type of sheets in a workbook
- Page formats
- Row and column styles
- Text, dates, numbers, formulas, and graphics, such as a company name and logo

When users open a template, Excel opens an untitled, unsaved copy of the template that contains all data, formatting, formulas, macros, styles, scenarios, and so forth that are contained in the template. The original template file remains unchanged.

**Tip** When you create a template that is linked to external data, Excel asks whether you want to remove the data before closing and refresh it automatically when the template is opened. Doing this reduces the file size of the template and can provide additional data security if you require the user to enter a password to reconnect to the external data source.

Excel templates behave differently than Word templates. One or more templates can be attached to a Word document, but an Excel workbook is based on — but is not attached to — a single template. In Word, changing a template (redefining a style, for example) affects all documents that the template is attached to. In Excel, conversely, there is no persistent link between the workbook and the template it is based on, and changing one does not affect the other.
Using Add-ins with Excel X

Add-ins are programs that add optional commands and features to Excel. For example, the Analysis ToolPak add-in provides a set of data analysis tools that can save steps when developing complex statistical or engineering analyses. A set of add-ins is installed by default with Excel X, and more add-ins are available from Tools on the Web (Tools menu) or from the Value Pack/Add-Ins folder on the Office v. X CD.

Add-ins must be installed before they can be used. Except where otherwise indicated, all add-ins are installed by default in the Microsoft Office X/Office/Add-ins folder on the user's computer. You can install add-ins from other locations, such as a network volume, and then load those add-ins on a user's computer by clicking Add-Ins (Tools menu) and then clicking Select. Once an add-in is installed, it appears on the Add-Ins available list in the Add-Ins dialog box (Tools menu).

Next, the add-in must be loaded into Excel. Loading an add-in makes the feature available in Excel and adds any associated commands to the appropriate menus. To load an add-in, select the check box next to the add-in on the Add-Ins available list. Users can also load an add-in for only the current Excel session by opening the add-in (File menu, Open command).

To conserve memory and improve performance, unload add-ins that are not often used by your users. Unloading an add-in removes its features and commands from Excel, but does not remove the add-in file from its original location or from the Add-Ins available list. To unload an add-in, clear the check box next to the add-in on the the Add-Ins available list. When you unload an add-in, it remains in memory until you restart Excel.

Users can also save workbooks as add-ins. Once they are created, add-ins are protected because they cannot be edited. You can create add-ins to assemble and distribute custom features that, from the user's point of view, act as if they are built into Excel. To create an add-in from the workbook, click Save As on the File menu, and then click Microsoft Excel Add-In on the Format pop-up menu.

Excel X recognizes files with file type "XLA8" or file extension .XLA as add-ins compiled from Excel workbooks. Add-ins can also be written in C code. When they are compiled from C code, add-ins should have the file type "XLL8" or the file extension .XLL.
Several add-ins are included with Excel. Some add-ins are installed and loaded automatically, whereas others are installed only and must be loaded in Excel manually. The following add-ins are included on the Office v. X CD:

<table>
<thead>
<tr>
<th>Add-in</th>
<th>Files</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis ToolPak</td>
<td>Analysis ToolPak</td>
<td>Adds financial, statistical, and engineering analysis tools and functions. This add-in can be installed from the Value Pack.</td>
</tr>
<tr>
<td></td>
<td>FuncRes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ProcDBRes</td>
<td></td>
</tr>
<tr>
<td>Analysis ToolPak VBA</td>
<td>Analysis ToolPak - VBA</td>
<td>Includes VBA functions for Analysis ToolPak. This add-in can be installed from the Value Pack.</td>
</tr>
<tr>
<td>Conditional Sum Wizard</td>
<td>Conditional Sum Wizard</td>
<td>Creates a formula that sums data in a list if the data matches criteria users specify. This add-in is installed with Excel X.</td>
</tr>
<tr>
<td>Euro Currency Tool</td>
<td>Eurotool.xla</td>
<td>Converts euro currency between ISO member countries. This add-in is installed with Excel X.</td>
</tr>
<tr>
<td></td>
<td>EuroConvert Library</td>
<td></td>
</tr>
<tr>
<td>HTML</td>
<td>HTML.XLA</td>
<td>Runs macros that use the legacy HTMLConvert function. This add-in can be installed from the Value Pack.</td>
</tr>
<tr>
<td>Lookup Wizard</td>
<td>Lookup Wizard</td>
<td>Creates a formula to look up data in a list by using another known value in the list. This add-in can be installed from the Value Pack.</td>
</tr>
<tr>
<td>Report Manager</td>
<td>Report Manager</td>
<td>Creates reports that contain different print areas within the workbook, custom views of the workbook, and scenarios. This add-in can be installed from the Value Pack.</td>
</tr>
<tr>
<td>Set Language</td>
<td>Set Language</td>
<td>Sets the current proofing language. This add-in can be installed from the Value Pack.</td>
</tr>
<tr>
<td>Solver</td>
<td>Solver.xla</td>
<td>Calculates solutions to what-if scenarios based on adjustable cells and constraint cells. This add-in can be installed from the Value Pack.</td>
</tr>
<tr>
<td></td>
<td>Solver Library</td>
<td></td>
</tr>
</tbody>
</table>
Notes

- The Add-Ins folder contains other files in addition to the files for add-ins listed here. Users do not need to load these additional files because they are pre-loaded when Excel is installed.

- If an add-in's source workbook contains a reference to another add-in, make sure that when the add-in is distributed, the referenced add-in is stored on the user's computer where the calling add-in can find it. The best strategy is to always store a referenced add-in in the folder that contains the calling add-in. When a source workbook is compiled as an add-in, Excel stores a path to the referenced add-in in the calling add-in.

Using AppleScript

The AppleScript scripting language can be used to automate tasks on Macintosh computers. To extend the functionality of Excel or automate repetitive tasks, you can create your own AppleScript scripts or applets. You can then distribute these scripts to your users, or use a script to automate Office v. X deployment in your organization. For information about AppleScript, visit the Mactopia Developer Resources Web site at http://www.microsoft.com/mac/resources/resources_main.asp?EmbFName=devresources.asp.

Configuring PowerPoint X

As you configure Microsoft PowerPoint® X for Mac for your organization, it is useful to understand the application's basic structure. Documents in PowerPoint X are called presentations. A presentation is a collection of slides, and each slide contains one or more objects, such as title text, a bulleted list, drawing, picture, or chart. Each object on a slide can have associated formatting, such as font settings, color, and animation effects. In addition, users can apply design templates, masters, color schemes, and slide layouts to give presentations a consistent look.

You can provide users with a custom template so that their PowerPoint presentations include design elements specific to your organization. For information about adding custom templates to your deployment of Microsoft Office v. X for Mac, see Adding Custom Documents and Templates on page 49.

If you are deploying PowerPoint X across your organization from a network installation point you can set preferences in PowerPoint X so that each user in the organization receives the same set of options and settings. For example, if the organization uses shared presentations, you can specify the default file location where the presentations are saved.
The first time each user runs PowerPoint X, several preferences files are created to store default settings such as the file format and save location. These preferences settings are saved in the PowerPoint Settings (10) and Microsoft Office Settings (10) files in the Users/username/Library/Preferences/Microsoft folder.

After you configure PowerPoint with the default settings that you want, copy the PowerPoint Settings (10) and Microsoft Office Settings (10) files to each user's Users/username/Library/Preferences/Microsoft folder.

For more information about deploying Office v. X, see Deploying Office v. X for Mac on page 42.

**Configuring Entourage X**

This chapter describes how to configure Microsoft Entourage™ X for Mac for users in your organization, including setting up mail accounts, working with identities, and protecting users' data.

**Helping Users Configure Entourage**

To help users get started with Entourage, you can do one of the following:

- Provide them with the setup information they need to configure Entourage themselves.
- Provide them with a default setup folder to ensure that each configures Entourage the same way.

**Providing Setup Information to Users**

When your users start Entourage for the first time, the Entourage Setup Assistant appears and leads them through the process of entering their personal information and setting up a mail account. If they send and receive messages by using mail accounts that you administer, make sure each user has the following required information:

- An e-mail address
- The mail server's protocol, POP or IMAP
- The address of the POP or IMAP server for receiving messages
- The address of the SMTP server for sending messages
- An account ID, the part of the e-mail address before the at sign (@)

If a user sets up a mail account that you do not administer, the information must be obtained from the user's Internet service provider (ISP).
Users might also need the following information:

- **TCP/IP settings**  To connect to the Internet, users might need to adjust the settings in the **Network** preference pane in **System Preferences** (Apple menu).

- **Proxy server settings**  If your organization uses a proxy server to send and receive messages, users can enter the settings on the **Proxies** tab of the **Mail & News Preferences** dialog box (Entourage menu, Mail & News Preferences command). Web proxy settings can be set only from the **Network** preference pane in **System Preferences** (Apple menu).

- **Security settings**  Depending on how the mail server is configured, users can specify more than the default level of security by setting some of the advanced sending and receiving options described in the next section.

If your server uses any or all of the features listed below, users can enable them in Entourage by clicking **Accounts** on the **Tools** menu, double-clicking the name of the account, and then clicking one of the following panels on the **Account Settings** tab: **Click here for advanced receiving options** or **Click here for advanced sending options**. For more information about secure mail accounts, see Microsoft Entourage Help. The features listed below can be enabled by using the advanced sending and receiving options in Entourage:

- **Secure sockets layer (SSL)**  When SSL is used, all of the information in a message, including the body, is encrypted. If the mail server requires this type of secure connection, users can enable SSL for SMTP, POP, and IMAP mail servers.

- **Override default ports**  The ports specified in Entourage must match the ports specified by the server. If the server requires SSL, the Entourage default port settings might need to be changed. Users can type new numbers in the **Override default <type of account> port** and **Override default SMTP port** boxes.

- **Password encryption**  If the mail server accepts password encryption, the **Always use secure password** check box should be selected.

- **SMTP authentication**  If the server requires SMTP authentication for sending messages, users can set up special logon information for that purpose. Entourage X supports SMTP logon information in the form of a standard account ID and password, a fully qualified user name (in the form of <domain\username>), or a valid e-mail address.

- **Domain for unqualified addresses**  This setting allows users to avoid typing the domain when addressing messages to people in that domain. For example, if the domain "microsoft.com" is specified, and the user is addressing a message to "someone@microsoft.com," the user can simply type "someone" and Entourage appends "microsoft.com" to the address.
Users can then finish configuring Entourage by setting preferences (Entourage menu, General Preferences and Mail & News Preferences commands), creating signatures (Tools menu, Signatures command), creating rules (Tools menu, Rules command), and so forth.

Providing a Default Setup Folder to Users

You can automate the setup process for new users by creating a folder that contains the default information they need. When you do so, Entourage uses the information you have provided instead of starting the Entourage Setup Assistant the first time a new user starts Entourage.

To provide a setup folder for users, start by creating a standard installation on page 46, or a creating a custom installation on page 47. Next, start Entourage to automatically create the Microsoft User Data folder in the Users/username/Documents folder. (For information about the Microsoft User Data folder, see The Entourage Database on page 28.) Within the Microsoft User Data folder, Entourage creates a folder that stores all of the data for the active identity. (For information about Entourage identities, see Identities on page 28.) Use the Account Setup Assistant to configure accounts with information that is the same for all users (for example, server addresses, advanced sending and receiving options, and the address of a company LDAP server). You must enter an e-mail address to complete the Account Setup Assistant, so you should enter a temporary placeholder e-mail address that your users can change later.

Tip You can also configure Entourage in other ways; for example, you can create a default signature (Tools menu, Signature command), set options in the Preferences dialog boxes (Entourage menu, General Preferences and Mail & News Preferences commands), or create a set of default rules (Tools menu, Rules command).

When you have finished configuring Entourage, copy the Microsoft User Data folder that has been created in the current user's Documents folder and distribute it to new users. The folder must be copied to the new user's Users/username/Documents folder before Entourage is started for the first time. If users start Entourage before the Microsoft User Data folder is copied to their computers, Entourage will create a Microsoft User Data folder that does not contain the information you have entered.

Make sure that new users complete the setup process by adding their own information after starting Entourage for the first time. For example, if you created a default mail account, users can double-click the account in the Accounts window (Tools menu, Accounts command), to add the following account information: name, e-mail address, account ID, and password. Also make sure that users complete the information in the contact that includes their own information, the Me contact. A user who does not complete this information will not be able to use some features of Entourage, such as getting driving directions, or of other Office v. X applications, such as automatically displaying his or her own return address in a letter or envelope created in Word.
Identities

If two or more users share Entourage on the same computer, each can set up a separate identity and configure Entourage to reflect his or her own preferences. This feature ensures that each user sees only his or her own account settings, schedules, Address Book and Calendar information, messages, tasks, and other items.

Identities do not provide password protection. If two or more of your users are sharing one computer, you can establish a secure password by creating separate user accounts for each user in the Users preference pane in System Preferences (Apple menu).

A user can switch identities at any time by clicking the Switch Identity command on the Entourage menu. The Entourage window closes, and the user can choose a different identity in the dialog box that appears. This dialog box can also appear automatically each time Entourage starts, so that each user can choose an identity when he or she begins using Entourage. When an identity is in use, it is called the "active identity."

Identities also customize the other Office v. X applications. In Microsoft Word, Excel, and PowerPoint, the active identity determines the author of a document. In any document created by using templates, such as the return address for a letter created in Word, the active identity determines which contact's address appears. Because a user can flag and receive a reminder through Office Notifications to follow up on any Office document, identities also ensure that each person receives reminders for only his or her own documents. In Word, the active identity determines which Address Book a person can use when creating envelopes and other types of documents. In Excel, the active identity determines whether a workbook is saved as a Web page automatically, or if an Auto Web Publish schedule has been created for the workbook. Schedules created while an identity is active can run only when that identity is active.

The Entourage Database

Entourage stores user data — such as preferences, rules, schedules, signatures, messages, contacts, and all other Entourage items — in a database in the Users/username/Documents folder. The first time Entourage is run, a new folder, called the Microsoft User Data folder, is created in the Documents folder. Within the Microsoft User Data folder, Entourage creates a folder called Office X Identities. This folder contains the Main Identity folder, which stores the data for the first identity. Each time you create a new identity, Entourage adds a folder for it to the Office X Identities folder.
Users can move the entire Microsoft User Data folder, or just the folder for any single identity, to a different location, such as another hard disk attached to the computer or on a network share. If they do so, they must also place an alias in the Users/username/Documents folder to the folder's original location. We do not recommend that users store the Microsoft User Data folder in the same folder as the Entourage program. Some users who have done this have accidentally deleted their data when they deleted the program folder.

**Backing Up the Database**

We highly recommend that users make regular backup copies of their data so it can be restored in the unlikely event that a hard disk is damaged or data becomes unreadable. To back up their data, users can drag the identity folders they want to back up to another volume, such as a different local or network hard disk or a high-capacity storage disk. To restore the data for an identity, users can drag the backup copy of the identity folder to the Office X Identities folder.

**Clearing the Cache of the Database**

If the number of messages in a specific IMAP folder does not match that on the IMAP server, users might need to refresh the Message list for that folder. To do so, they should open the folder, and then press `⌘`+OPTION+L. If this does not solve the problem, users can try emptying the cache.

Entourage X keeps a copy of an IMAP, Hotmail, or news message in the database until the original item is deleted from the server. If users want to clear these cached copies without deleting their corresponding items from the server, they can hold down CONTROL and click the mail or news server's icon or the IMAP folder in the Folders list. On the contextual menu that appears, they should click **Empty Cache**. After the cache has been cleared, users might want to compact the database, as explained in the next section, to reclaim space on the disk.

**Compacting the Database**

When a user deletes an item, Entourage does not automatically reduce the size of its database. However, the corresponding space is free to be reused when new items are added to the database. In certain situations, a user might want to reclaim space on a hard disk by compacting the database (for example, after deleting many Entourage items). The user can compact the database by performing a typical rebuild of the database. For more information about rebuilding, see the next section and Microsoft Entourage Help.
Rebuilding the Database

Microsoft Entourage stores data such as signatures, messages, contacts, and other items in a database. If users have problems starting Entourage or opening or viewing items, or if Entourage performs more slowly than it should, the database might be damaged and the user may need to rebuild it.

**Determine Whether the Database is Damaged**

If the database is damaged, users might notice any of the following or other similar symptoms:

- When users double-click an item, the item that opens is not the item that they double-clicked.
- Blank lines appear in the Message list.
- Users can't find information that they are sure they added, such as a calendar event or a contact.
- When users perform a search, the search results do not match the criteria they set.

If you suspect that the database is damaged, try to ascertain the source of the problem before you attempt to fix it. Because repairing the database can sometimes cause data loss, first make sure that the user did not accidentally cause the symptom — for example, by moving a message to the wrong folder. Also, make sure that the problem is not the result of general computer problems, such as a damaged or fragmented hard disk by running a disk diagnostics and repair program, such as Apple Disk Utility. For more information about identifying and repairing hard disk problems, see the documentation for the disk utility program.

**Determine Which Rebuild Option to Use**

If you determine that the database is damaged, you might need to rebuild it. Entourage provides two options for doing so:

**Typical rebuild**  Optimizes data storage and reduces the size of the database. It is also the first step in troubleshooting database problems.

**Advanced rebuild**  Repairs damaged data and reduces the size of the database. Because this option repairs data, which can result in data loss, you should use it only after you've performed a typical rebuild of the database and determined that problems continue to occur.
Also, it's important to note that, after you perform an advanced rebuild, the user will have to do the following:

- Re-create links between items, if the user previously linked items to one other.
- Re-download messages from the user's IMAP, Hotmail, and news accounts.
- Reset column preferences in message folders for IMAP, Hotmail, and news accounts.
- Reenter settings for schedules that send or receive messages from IMAP, Hotmail, or news accounts.
- Reenter settings for rules that copy or move messages to folders on an IMAP or Hotmail server.

You should rebuild the database only if users have problems starting Entourage or viewing, opening, and storing items.

1. Quit all Microsoft Office programs, including Entourage.
2. With CAPS LOCK off, hold down OPTION and start Entourage.
3. In the dialog box, do one of the following:
   - To optimize data storage and reduce the size of the Entourage database, click Typical Rebuild.
   - To fix corrupted data and reduce the size of the Entourage database, click Advanced Rebuild.

   **Caution** Some of the data might be lost if you choose the Advanced Rebuild option. You should use this option only if you have already performed a typical rebuild and continue to experience problems starting Entourage or storing data.

4. Click Rebuild.

**Note** When you rebuild the database, Entourage adds two files to the user's identity folder in the Documents/Microsoft User Data/Office X Identities folder: Old Database and Old Database Cache. After you determine that rebuilding the database fixed the problems, you can move these files to the Trash or keep them as a backup copy of the database.
Entourage and Microsoft Exchange Server

Entourage was not specifically developed as a client for Microsoft Exchange Server. However, it can be used to access accounts on a server that is running Exchange Server, as long as that version of Exchange Server supports the Internet protocol for that type of account. The following table shows the protocols supported by recent versions of Exchange Server.

<table>
<thead>
<tr>
<th>This version of Exchange Server</th>
<th>Supports these protocols</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.0</td>
<td>SMTP</td>
</tr>
<tr>
<td>5.0</td>
<td>SMTP, NNTP, LDAP, POP3</td>
</tr>
<tr>
<td>5.5</td>
<td>SMTP, NNTP, LDAP, POP3, IMAP4</td>
</tr>
<tr>
<td>2000</td>
<td>SMTP, NNTP, LDAP, POP3, IMAP4</td>
</tr>
</tbody>
</table>

For example, if the mail server is running Exchange Server version 5.5 or later, users can set up their Exchange mailboxes as POP or IMAP mail accounts and set up an NNTP server as a news account. If your Exchange server does not require NTLM authentication, users can also set up the Exchange Global Address List as an LDAP directory service. Entourage users can also exchange meeting requests with Outlook users through the iCalendar standard.

Macintosh users can take full advantage of the messaging and collaboration features of Exchange Server by using Microsoft Outlook® 2001 for Mac, which they can download from the Mactopia Outlook 2001 Web site at http://www.microsoft.com/mac/products/outlook/.

Authentication with Microsoft Exchange Server Using NTLM

Entourage X supports NTLM version 2 authentication, which provides security beyond the NTLM authentication supported by Entourage 2001 and Outlook Express 5. If your users are using Entourage X with Microsoft Exchange Server or have upgraded an account from Entourage 2001 or Outlook Express 5 that was being used with Microsoft Exchange Server, they should change their user name to avoid having their password sent as clear text. Clear text passwords are not encrypted. Entourage X does not work with Exchange LDAP directory services if NTLM authentication is enabled for Exchange Server access.
To avoid getting a failed-password message or having a password sent as clear text, make sure that NTLM 2 authentication is used by including the account domain in the Account ID.

**Include the account domain in the Account ID**

1. On the **Tools** menu, click **Accounts**.
2. Double-click the Microsoft Exchange IMAP or POP account you want to change.
3. In the **Account ID** box, type a fully qualified user name (in the form of `domain\username`).

**Secure Passwords**

Entourage always tries to use the most secure authentication method. However, to ensure that Entourage uses only the most secure method — rather than a less secure method if the most secure method fails — use the following steps.

**Force Entourage to always use a secure password**

1. On the **Tools** menu, click **Accounts**.
2. Double-click the Microsoft Exchange IMAP or POP account you want to change.
3. Click **Click here for advanced receiving options**.
4. Select the **Always use secure password** check box.
5. Click **OK**.

**Complex HTML**

In Entourage X, complex HTML is HTML that adds special formatting, such as tables, navigation menus, or other effects, to a message. Although users cannot create complex-HTML messages in Entourage, users can receive them. Because such messages contain special formatting, they typically take longer to display when you open or preview them.
Complex HTML is most frequently used by organizations to send newsletters, Web pages, and announcements as messages. However, it can be used by anyone to run scripts or download files that might harm computers or pose a risk to users’ privacy. To help ensure that users remain safe from malicious software, Entourage does not run scripts or download files that are specified by complex-HTML messages. To disable complex HTML completely, you or your users can clear the Display complex HTML in messages check box (Entourage menu, Mail & News Preferences command, Read tab). If complex HTML is disabled, users can continue to receive complex-HTML messages, but all of the special formatting is removed when such messages are opened or previewed. This setting allows Entourage to display such messages more quickly and to further protect the computers and the privacy of the users in your organization.

**AppleScript**

The AppleScript scripting language can be used to automate tasks on Macintosh computers. To extend Entourage functionality or automate repetitive tasks, you can create your own AppleScript scripts or applets. You can then distribute these scripts to your users, or use a script to automate Office v. X deployment in your organization. For information about AppleScript, visit the Mactopia Developer Resources Web site at http://www.microsoft.com/mac/resources/resources_main.asp?EmbFName=devresources.asp.

**Known Issues in Word X**

For the latest information about known issues in Microsoft® Word X for Mac, visit the Mactopia Support Web site at http://www.microsoft.com/mac/support/mysupport.asp.

**Customize tools**  The Toolbar Button Editor no longer permits users to paste their own images into the dialog box as new button images. Custom toolbars created in previous versions of Word do not retain their custom button images after the toolbars are upgraded to Word X. Quick Customize of toolbar buttons has been removed from Word X.

**Encapsulated PostScript graphics and PostScript printers**  Encapsulated PostScript (EPS) graphics might print as low resolution preview images on PostScript printers. Apple will use Software Update (Apple menu, System Preferences command, Software Update pane) to provide an update that will fix the problem. For more information about updates, visit Apple's Web site at http://www.apple.com/.

**Printing on Canon printers** To print on a Canon printer, users must click Print on the File menu or press ⌘+P. Users cannot print by clicking the Print button on the toolbar.

**Slow printing** Documents containing texture fills, picture fills, WordArt, border art, and wavy borders might print slowly in Office v. X.
Printing transparent objects and pictures  Some drawing objects and pictures that look transparent on the computer screen will not appear transparent when printed. The transparency of drawing objects that have simple fills, such as solid colors, will print correctly. The transparency of drawing objects that have complex fills — such as gradients, patterns, textures, and pictures — will not print correctly. The transparency of pictures, such as GIF and JPEG files, will not print correctly. Apple might use Software Update (Apple menu, System Preferences command, Software Update pane) to provide updates that will fix these problems. For more information about updates, visit Apple's Web site at http://www.apple.com/.

The following steps might allow users to print transparent drawing objects.

1. Select the transparent drawing object or objects, and then click Copy on the Edit menu.
   
   To select multiple objects, select the first object, hold down SHIFT, and then select the other objects.

2. On the Edit menu, click Paste Special.

3. In the Paste Special dialog box, click Picture, and then click OK.

4. This process creates a duplicate of the drawing object and converts it into a picture with a light fill pattern that mimics transparency when printed.

5. Place the new picture where you want it on the page, and then delete the original drawing object.

6. On the File menu, click Print to print the new transparent graphic.

   Note  The new graphic will look transparent when printed, but it still might not look as good printed as it does on the screen. Some unavoidable degradation of an image occurs during the process of converting it from a drawing object to a picture.

Pictures and HTML form objects  If users insert a picture next to an HTML form object, the picture's anchor may be located within the hidden text of the form object. If the picture's anchor is in the hidden text of the object, the picture might not be saved if the user saves the document as HTML.

File name and font name length  Word does not accept file names longer than 31 characters for saving new files. However, users can open and save files that already have file names that are longer than 31 characters.

Fonts with names longer than 31 characters will not appear in the Font list.
**Unicode characters in file names**  Word cannot open files with Unicode characters in their file names. Users must rename these files before opening them in Word.

**Word 95/6.0 file format**  Word X does not support saving in the Word 95/6.0 file format. If your users need to exchange files with Word 6.0 users, the Word 6.0 users should install the freely distributable Word 97-X Converter, which will allow Word 6.0 users to open documents created with Word 97 and later.

For more information about the Word 97-X Converter, see the Guide to the Value Pack file in the Value Pack folder on the Office v. X CD.

**TextEdit files in Word**  Word cannot open TextEdit files that contain pictures. For files that contain pictures, TextEdit uses a variant of Rich Text Format (RTF) that Word does not support.

**F12 key**  By default, the keyboard shortcut for the **Save As** command in Word X is the F12 key. If pressing F12 does not bring up the **Save As** dialog box, users can reassign a keyboard shortcut for this command by clicking **Keyboard** in the **Customize** dialog box (**Tools** menu, **Customize** command). For more information about assigning keyboard shortcuts, search for **Assign shortcut keys to a command or other item** in **Microsoft Word Help** (**Help** menu) in Word X.

**Scanners and digital cameras**  Office v. X supports the direct insertion of pictures into Office documents from scanners and digital cameras that support TWAIN (**Insert** menu, **Picture** submenu, **From Scanner or Camera** command). Office v. X does not support the direct insertion of pictures into Office documents from scanners or digital cameras that require Adobe PhotoShop plug-ins for direct connection. To use pictures from devices that support Adobe Photoshop plug-ins or Picture Transfer Protocol (PTP) instead of TWAIN, users must save the pictures to their hard disk before inserting them into an Office document (**Insert** menu, **Picture** submenu, **From File** command). For the latest information about digital imaging support in Office v. X — including a list of supported scanners and digital cameras — visit the **Office v. X digital imaging area** of the Mactopia Web site at http://www.microsoft.com/mac/office/x/imaging/.

**Office Assistant**  The first time that the Office Assistant is displayed, the window might be blank. If this occurs, users can click on the Desktop and then switch back to the program to see the Office Assistant.
Known Issues in Excel X

For the latest information about known issues in Microsoft Excel X for Mac, visit the Mactopia Support Web site at http://www.microsoft.com/mac/support/mysupport.asp.

**Spreadsheet size limits**  Excel X will truncate the portions of an imported FileMaker database that exceed 256 fields (columns), 65,535 records (rows), or the contents of any record that exceeds 32,767 characters. If users import a FileMaker database that exceeds any of these limits, Excel X should display a message, but sometimes it does not. For additional information about this issue, read the article Import FileMaker Pro files into Excel X on the Mactopia Web site at http://www.microsoft.com/mac/excelx/excelx_main.asp?embfpath=featartx&embfname=xl_importFileMaker.asp.

**Customize tools**  The Toolbar Button Editor no longer permits users to paste their own images into the dialog box as new button images. Custom toolbars created in previous versions of Excel do not retain their custom button images after the toolbars are upgraded to Excel X. Quick Customize of toolbar buttons has been removed from Excel X.

**Encapsulated PostScript graphics and PostScript printers**  Encapsulated PostScript (EPS) graphics might print as low resolution preview images on PostScript printers. Apple will use Software Update (Apple menu, System Preferences command, Software Update pane) to provide an update that will fix the problem. For more information about updates, visit Apple's Web site at http://www.apple.com/.

**Printing on Canon printers**  To print on a Canon printer, users must click Print on the File menu or press ⌘+P. Users cannot print by clicking the Print button on the toolbar.

**Slow printing**  Documents containing texture fills, picture fills, WordArt, border art, and wavy borders might print slowly in Office v. X.

**Printing transparent objects and pictures**  Some drawing objects and pictures that look transparent on the computer screen will not appear transparent when printed. The transparency of drawing objects that have simple fills, such as solid colors, will print correctly. The transparency of drawing objects that have complex fills — such as gradients, patterns, textures, and pictures — will not print correctly. The transparency of pictures, such as GIF and JPEG files, will not print correctly. Apple might use Software Update (Apple menu, System Preferences command, Software Update pane) to provide updates that will fix these problems. For more information about updates, visit Apple's Web site at http://www.apple.com/.
The following steps might allow users to print transparent drawing objects.

1. Select the transparent drawing object or objects, and then click **Copy** on the **Edit** menu.

   To select multiple objects, select the first object, hold down **SHIFT**, and then select the other objects.

2. On the **Edit** menu, click **Paste Special**.

3. In the **Paste Special** dialog box, click **Picture**, and then click **OK**.

4. This process creates a duplicate of the drawing object and converts it into a picture with a light fill pattern that mimics transparency when printed.

5. Place the new picture where you want it on the page, and then delete the original drawing object.

6. On the **File** menu, click **Print** to print the new transparent graphic.

   **Note** The new graphic will look transparent when printed, but it still might not look as good printed as it does on the screen. Some unavoidable degradation of an image occurs during the process of converting it from a drawing object to a picture.

**Scanners and digital cameras** Office v. X supports the direct insertion of pictures into Office documents from scanners and digital cameras that support TWAIN (**Insert** menu, **Picture** submenu, **From Scanner or Camera** command). Office v. X does not support the direct insertion of pictures into Office documents from scanners or digital cameras that require Adobe Photoshop plug-ins for direct connection. To use pictures from devices that support Adobe Photoshop plug-ins or Picture Transfer Protocol (PTP) instead of TWAIN, users must save the pictures to their hard disk before inserting them into an Office document (**Insert** menu, **Picture** submenu, **From File** command). For the latest information about digital imaging support in Office v. X — including a list of supported scanners and digital cameras — visit the Office v. X digital imaging area of the Mactopia Web site at http://www.microsoft.com/mac/officex/imaging/.

**Office Assistant** The first time that the Office Assistant is displayed, the window might be blank. If this occurs, users can click on the Desktop and then switch back to the program to see the Office Assistant.
Known Issues in PowerPoint X

For the latest information about known issues in Microsoft PowerPoint® X, visit the Mactopia Support Web site at http://www.microsoft.com/mac/support/mysupport.asp.

**Unicode and 31-character file names**  PowerPoint does not accept file names longer than 31 characters for saving new files (25 characters for Web presentations). However, PowerPoint can open files that have file names that are longer than 31 characters. Users can save these files with their original file names, but if they use the **Save As** command (**File** menu), they must use shorter file names. PowerPoint also cannot open files with file names that include Unicode characters. To open such a file, users must rename the file in the Finder before opening the file.

**Customize tools**  The Toolbar Button Editor no longer permits users to paste their own images into the dialog box as new button images. Custom toolbars created in previous versions of PowerPoint do not retain their custom button images after the toolbars are upgraded to PowerPoint X. Quick Customize of toolbar buttons has been removed from PowerPoint X.

**White lines in print preview**  When a user clicks **Preview** in the **Print** dialog box (**File** menu, **Print** command) to see what his or her presentation will look like when it prints, the user might see white lines on their graphics. These white lines will not appear in the printed presentation, but the user can remove them from the preview by clicking the **AntiAliasing** command on the **Display** menu to clear the check mark. Graphics might appear jagged after the **AntiAliasing** command has been cleared; however, the graphics will be smooth when the presentation prints.

**Printing on Epson printers**  The right side of a slide's border might not print on Epson inkjet printers. To print the whole slide, users can scale the slide to fit the paper.

**Scale slide to fit paper**

1. On the **File** menu, click **Print**.
2. On the pop-up menu that contains the words **Copies & Pages**, click **Microsoft PowerPoint**.
3. Select the **Scale to Fit Paper** check box.

**Printing on Hewlett-Packard printers**  Picture fills might print upside down on Hewlett-Packard PostScript printers.

**Slow printing**  Presentations that contain texture fills, picture fills, WordArt, border art, and wavy borders might print slowly in Office v. X.
**Printing transparent objects and pictures** Some drawing objects and pictures that look transparent on the computer screen will not appear transparent when printed. The transparency of drawing objects that have simple fills, such as solid colors, will print correctly. The transparency of drawing objects that have complex fills — such as gradients, patterns, textures, and pictures — will not print correctly. The transparency of pictures, such as GIF and JPEG files, will not print correctly. Apple might use Software Update (Apple menu, System Preferences command, Software Update pane) to provide updates that will fix these problems. For more information about updates, visit [Apple's Web site](http://www.apple.com/).

The following steps might allow users to print transparent drawing objects.

1. Select the transparent drawing object or objects, and then click **Copy** on the **Edit** menu.
   To select multiple objects, select the first object, hold down **SHIFT**, and then select the other objects.
2. On the **Edit** menu, click **Paste Special**.
3. In the **Paste Special** dialog box, click **Picture**, and then click **OK**.
4. This process creates a duplicate of the drawing object and converts it into a picture with a light fill pattern that mimics transparency when printed.
5. Place the new picture where you want it on the page, and then delete the original drawing object.
6. On the **File** menu, click **Print** to print the new transparent graphic.
   **Note** The new graphic will look transparent when printed, but it still might not look as good printed as it does on the screen. Some unavoidable degradation of an image occurs during the process of converting it from a drawing object to a picture.

**Encapsulated PostScript graphics and PostScript printers** Encapsulated PostScript (EPS) graphics might print as low resolution preview images on PostScript printers. Apple will use Software Update (Apple menu, System Preferences command, Software Update pane) to provide an update that will fix the problem. For more information about updates, visit [Apple's Web site](http://www.apple.com/).

**Printing on Canon printers** To print on a Canon printer, users must click **Print** on the **File** menu or press **⌘+P**. Users cannot print by clicking the **Print** button on the **Standard** toolbar.
Scanners and digital cameras  Office v. X supports the direct insertion of pictures into Office documents from scanners and digital cameras that support TWAIN (Insert menu, Picture submenu, From Scanner or Camera command). Office v. X does not support the direct insertion of pictures into Office documents from scanners or digital cameras that require Adobe PhotoShop plug-ins for direct connection. To use pictures from devices that support Adobe Photoshop plug-ins or Picture Transfer Protocol (PTP) instead of TWAIN, users must save the pictures to their hard disk before inserting them into an Office document (Insert menu, Picture submenu, From File command). For the latest information about digital imaging support in Office v. X — including a list of supported scanners and digital cameras — visit the Office v. X digital imaging area of the Mactopia Web site at http://www.microsoft.com/mac/officex/imaging/.

OLE objects and toolbars  If users insert an OLE object — such as a chart from Excel or a table from Word — into their presentations, the toolbars in the PowerPoint window might disappear. To display the toolbars, users can switch to the Finder, and then switch back to PowerPoint.

Office Assistant  The first time that the Office Assistant is displayed, the window might be blank. If this occurs, users can click on the Desktop and then switch back to the program to see the Office Assistant.

Known Issues in Entourage X

For the latest information about known issues in Microsoft Entourage™ X for Mac, visit the Mactopia Support Web site at http://www.microsoft.com/mac/support/mysupport.asp.

Hotmail access  Due to late changes in the MSN® Hotmail® infrastructure, users cannot currently access Hotmail accounts from Entourage X. However, they can download a patch that will enable access to Hotmail from Entourage X from the Hotmail integration section of the Mactopia Web site at http://www.microsoft.com/mac/resources/resources_main.asp?EmbFName=passportinfo.asp.

Entourage Database file size limit  If the size of the Entourage Database file exceeds 2 GB, data loss will occur. To work around this limitation, users can delete messages they no longer need or export messages to an MBOX file. For information about exporting messages to an MBOX file, see Entourage X Help.

Sending messages containing inline multimedia elements to Outlook 2000 users  Recipients who use Microsoft Outlook® 2000 will be unable to display inline multimedia elements that Entourage users send in e-mail messages. The elements will appear as attachments. This problem does not affect users of Outlook 2002 or apply to multimedia elements that users attach to a message.
**Printing on Canon printers**  To print on a Canon printer, users must click **Print** on the **File** menu or press ⌘+P. Users cannot print by clicking the **Print** button on the toolbar.

**Office Assistant**  The first time that the Office Assistant is displayed, the window might be blank. If this occurs, users can click on the Desktop and then switch back to Entourage to see the Office Assistant.

---

**Deployment Basics**

This chapter describes the requirements for setting up a network installation point for Microsoft® Office v. X for Mac, the features of the Office v. X installer applications, and the system requirements for Office v. X for Mac.

Retail versions of Office v. X cannot be deployed across an organization. To deploy Office v. X, your organization must obtain a volume license. For more information about volume licensing, see [Licensing Office v. X for Mac](#) on page 12.

To find out about the ways you can deploy Office v. X in your organization, see [Deployment Methods](#) on page 45. To learn about standard or custom installation options and creating a Microsoft Office v. X folder for deployment, see [Deployment Options](#) on page 46.

---

**Network Installation Point Requirements**

To set up a network installation point for Office v. X, you need:

- A server operating system capable of handling Macintosh files (for example, AppleShare IP, Mac OS X Server, or Microsoft Windows® 2000 Server or later with [AppleTalk network integration](#))
- Sufficient server hard disk space for the Microsoft Office v. X folder you want to deploy
- The privileges necessary to create shared folders on the server and to assign **privilege levels** to them
- The privileges necessary to create user groups and to assign users to groups
About the Installers

Deployment options for Office v. X include both drag-and-drop installation and a Microsoft Office Installer application. The Value Pack contains its own installer application. Office v. X does not use the First Run Installation process that Office 2001 used, so it does not automatically detect and restore missing files each time an Office application is started. However, Office installs additional fonts if necessary when a user starts an Office application for the first time. For more information about controlling the installation of Office fonts, see Controlling Font Installation on page 47.

Drag-and-Drop Installation

You can drag the Microsoft Office X folder directly from the Office v. X CD-ROM or a network folder to a local or network volume. This method results in a standard installation, the equivalent of using the Microsoft Office Installer application to perform an Easy Install. Installation is not complete until any one of the Office applications is started. When the first Office application is started, Office v. X installs additional fonts (if necessary) and collects user information.

Microsoft Office Installer

The Microsoft Office Installer application is on the Office v. X CD-ROM. The installer allows you or your users to select the location where the Microsoft Office X folder will be created. The Microsoft Office Installer supports two options: Easy Install, which installs all Office v. X components, and Custom Install, which allows you or your users to choose which components to install.

Value Pack Installer

The Value Pack Installer application is in the Value Pack folder on the Office v. X CD-ROM. The Value Pack Installer allows you or your users to install Value Pack components to an installed copy of Microsoft Office v. X.

For more information about specific Value Pack components, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.
Office v. X System Requirements

Computers running Office v. X must meet the following minimum requirements.

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>PowerPC G3 or later, Mac OS X compatible</td>
</tr>
<tr>
<td>Operating system</td>
<td>Mac OS X version 10.1 or later</td>
</tr>
<tr>
<td>Memory</td>
<td>128 MB of RAM</td>
</tr>
<tr>
<td>Available hard disk space</td>
<td>196 MB of available hard disk space for a default installation of Office; the hard-disk space requirement varies according to the components installed and the amount of data users store in Office. Also, installation of Value Pack components requires additional hard disk space. The hard disk should be in Mac OS Extended (HFS+) format, the default format for Mac OS X; although you can perform a drag-and-drop installation of and run Office v. X from a hard disk that is in another format, Microsoft does not currently support such a configuration. To determine the format of the hard disk, see the Devices and Volumes tab of Apple System Profiler.</td>
</tr>
<tr>
<td>Disk drives</td>
<td>CD-ROM drive or a connection to a network if you are installing Office from a network volume.</td>
</tr>
<tr>
<td>Monitor</td>
<td>Monitor that can display 256 colors and a resolution of 800 × 600 or higher. A monitor that can display thousands or millions of colors and a resolution of 1024 × 768 or higher is recommended.</td>
</tr>
</tbody>
</table>

To use all of the features available in Office v. X, it is recommended that users have the following additional items and services:

- **Modem**: 14.4 Kbps or higher.
- **Internet Access**: Internet connection through either an Internet service provider (ISP) or a network. Internet access might require a separate fee to an ISP; local or long-distance telephone charges might also apply.
Deployment Methods

You can deploy Microsoft Office v. X for Mac to your organization from a network installation point. In most cases, making Office v. X available for installation from one or more network installation points is the easiest deployment method.

Retail versions of Office v. X cannot be deployed across an organization. To deploy Office v. X, your organization must obtain a volume license. For more information about volume licensing, see Licensing Office v. X for Mac on page 12.

Deploying Office v. X from a Network Installation Point

To set up a network installation point for Office v. X, you need:

- A server operating system capable of handling Macintosh files (for example, AppleShare IP, Mac OS X Server, Microsoft Windows 2000 Server or later with AppleTalk network integration)
- Sufficient server hard disk space for the Microsoft Office X folder you want to deploy
- The privileges necessary to create shared folders on the server and to assign privilege levels to them
- The privileges necessary to create user groups and to assign users to groups

For more information about sharing folders, see the documentation for your server operating system.

Prepare the network installation point

1. Create a folder on the server and make it accessible from the network. This folder is referred to as the network installation point.

2. Copy the Microsoft Office v. X deployment folder to the network installation point.

   To ensure that your users install the Microsoft Office X folder properly, copy the Microsoft Office X folder into the folder designated as the network installation point instead of making the Microsoft Office X folder itself the network installation point.

3. Set the access privileges for the network installation point.

Your users can begin installing Microsoft Office v. X by copying the Microsoft Office X folder from the network installation point to their computers.
Deployment Options

The standard installation of Microsoft Office v. X for Mac is designed to address the most common requirements of Office users in a business or academic environment. If groups within your organization require specialized configurations of Office v. X, you can customize Office to fit their needs. For example, you can add your organization's custom documents and templates to the Office v. X deployment folder and install Value Pack components.

This chapter describes the process of creating a deployment folder — a folder that will be made available over a network to users for drag-and-drop installation. The Deployment Methods on page 45 chapter describes how to deploy this folder after it has been created.

Retail versions of Office v. X cannot be deployed across an organization. To deploy Office v. X, your organization must obtain a volume license. For more information about volume licensing, see Licensing Office v. X for Mac on page 12.

Creating a Standard Installation

The standard installation of Microsoft Office v. X includes all Office applications and supporting files; it does not install any of the Value Pack components.

Create a standard Microsoft Office v. X deployment folder

1. Insert the Office v. X CD-ROM into the CD-ROM drive of the local computer.
2. Double-click the Microsoft Office Installer application.
3. On the upper-left pop-up menu, click Easy Install.
4. On the Install Location pop-up menu, click the local volume you want.
5. Click Install.
6. Type the name and organization you want to use in all subsequent installations of Office v. X from this deployment folder.

The standard Microsoft Office v. X folder is ready to be deployed. You can now customize Office v. X by adding Value Pack components on page 50, controlling font installation on page 47, configuring preferences settings on page 48, or adding custom documents, templates, scripts, and sound sets on page 49.
Creating a Custom Installation

You can use the Custom Install option in the Microsoft Office Installer to choose applications and options for creating a custom Office deployment folder.

Create a custom Microsoft Office v. X deployment folder

1. Insert the Office v. X CD-ROM into the CD-ROM drive of the local computer.
2. Double-click the Microsoft Office Installer application.
3. On the upper-left pop-up menu, click Custom Install.
4. Clear the check box next to each component you do not want to include in the installation.
5. On the Install Location pop-up menu, click the local volume you want.
6. Click Install.
7. Type the name and organization you want to use in all subsequent installations of Office v. X from this deployment folder.

The custom Microsoft Office v. X folder is ready to be deployed. You can now customize Office v. X by adding Value Pack components on page 50, controlling font installation below, configuring preferences settings on page 48, or adding custom documents, templates, scripts, and sound sets on page 49.

Controlling Font Installation

The first time any Office application is run using a user account that has never run an Office v. X application, Office checks to see if the Wingdings font is installed in either the /Library/Fonts folder or the /Users/username/Library/Fonts folder, and is active on the system. If the Wingdings font is not found (for example, if you or your users use a font management utility to temporarily enable or disable installed fonts), Office installs it along with additional fonts found in the Microsoft Office X/Office/Fonts folder. This process is called Runtime Installation (RI).

If the user account being used to run Office for the first time has Write privileges to the /Library/Fonts folder, Office will install the fonts into that folder. Otherwise, Office will install the fonts in the /Users/username/Library/Fonts folder.

If your organization uses a centralized font management utility, and you want to avoid font conflicts between Office v. X and specialized font configurations, you might want to prevent Office v. X from installing any fonts during Runtime Installation. To prevent Office from installing fonts, remove the Do Fonts file from the Microsoft Office X/Office folder before you deploy it. You can also prevent installation of fonts by using the Microsoft Office Installer to create a custom installation that does not include fonts. To do this, clear the check box next to Microsoft TrueType Fonts under Office Tools in the Custom Install list before you install.
Configuring Preferences Settings

You can include custom preferences settings for Microsoft Word, Excel, PowerPoint, and Entourage in your deployment. For example, you can specify the default format in which Word documents should be saved. By including custom preferences settings, you can ensure that each user in your organization has the same set of default options and settings.

The first time an Office v. X application is started, Office determines whether the appropriate settings files for the application are stored in the Users/username/Library/Preferences/Microsoft folder. If the Microsoft folder and the appropriate settings files are not found, the application creates them. If the Microsoft folder and the appropriate settings files are found, the application uses the preferences settings stored in the settings files. For this reason, you can deploy a standard set of preferences settings for Word, Excel, PowerPoint, and Entourage by deploying the Microsoft folder and the settings files it contains in addition to deploying the Microsoft Office v. X deployment folder.

**Tip**  Consider automating the process of deploying preferences settings by creating an AppleScript script file that copies your deployed Microsoft folder to each user's Preferences folder. See the Developer Resources section of the Mactopia Web site at http://www.microsoft.com/mac/resources/resources_main.asp?EmbFName=devresources.asp.

For information about some of the preferences settings you can deploy for Office v. X applications, see Configuring Word X on page 12, Configuring Excel X on page 18, Configuring PowerPoint X on page 24, and Configuring Entourage X on page 25.
Adding Custom Documents, Templates, Scripts, and Sound Sets

You can customize Office v. X installations by adding custom documents, templates, add-ins, scripts, and other items to the Office v. X deployment folder.

<table>
<thead>
<tr>
<th>To add</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>An Office document that will be opened whenever the corresponding Office application is run</td>
<td>Copy your custom Microsoft Word, Excel, or PowerPoint startup documents to the appropriate folders in the Microsoft Office X/Office/Startup folder.</td>
</tr>
<tr>
<td>Custom templates to Office</td>
<td>Copy your custom templates for Word, Excel, or PowerPoint to the appropriate folders in the Microsoft Office X/Templates folder.</td>
</tr>
<tr>
<td>Custom add-ins to Excel</td>
<td>Copy your custom add-ins to the Microsoft Office X/Office/Add-ins folder.</td>
</tr>
<tr>
<td>Custom AppleScript scripts to Entourage</td>
<td>Copy your custom scripts to the Microsoft Office X/Office/Entourage First Run/Entourage Script Menu Items folder.</td>
</tr>
<tr>
<td>Custom sound sets to Entourage</td>
<td>Copy your custom sound set files to the Microsoft Office X/Office/Entourage First Run/Entourage Sound Sets folder.</td>
</tr>
</tbody>
</table>
Adding Value Pack Components

You can install most Value Pack components in the deployment folder before deploying Office to your users. The Value Pack Installer can install components only in an existing Microsoft Office X folder on a local volume. The installer cannot install components in a folder on a network. You can also deploy the entire Value Pack folder with the Microsoft Office v. X deployment folder so your users can run the Value Pack Installer to install the components they want.

Add Value Pack components to the deployment folder

1. Insert the Office v. X CD-ROM into the CD-ROM drive of the computer on which you installed the deployment folder.

2. In the Value Pack folder, double-click the Value Pack Installer application.

3. Select the check box next to each component you want to include in the installation, and then click Continue.

Note The additional fonts in the Value Pack are installed into the /Users/username/Library/Fonts folder. Unlike Office 2001, Office v. X does not need to be installed before you can install these fonts.

For more information about specific Value Pack components, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.
File Formats in Word X

A file format determines how information is stored in a document. Microsoft® Word X for Mac uses the same file format as Word 2001 (Mac), Word 98 (Mac), Word 2002 (Microsoft Windows®), Word 2000 (Windows), and Word 97 (Windows). Users of all of these versions of Word can share documents without installing special converters. This section describes strategies for sharing documents among users within an organization, including those who do not have Word installed on their computers.

Converting Documents to Word X from Earlier Versions of Word

Users can open documents created in earlier versions of Word directly in Word X. All data and formatting created in these versions of Word are fully supported in Word X.

Macros

Word X supports Microsoft Visual Basic® for Applications (VBA) macros created in Word 98.

Word X automatically converts WordBasic code to the equivalent VBA code whenever users:

1. Open a Word 5.x or 6.x document or template that contains WordBasic macros
2. Create a new document based on a Word 5.x or Word 6.x template that contains WordBasic macros
3. Use the Templates and Add-Ins command on the Tools menu to attach a Word 5.x or Word 6.x template to a Word X document

While Word X is converting macros, a message appears in the status bar.

Caution  The conversion from WordBasic to VBA happens automatically in Word X, and there is no undo feature. Users who want to reuse the WordBasic macros in Word 5.x or Word 6.x should make backup copies of the files before the files are opened in Word X.

Compatibility Options

The alignment and layout of some items in Word X differ from those in previous versions of Word and other applications. For example, line breaks and page breaks in Word X might appear differently in Word 98 or Word 5.1.
Users can customize the way in which documents created in previous versions of Word and other applications are displayed in Word X by clicking **Compatibility** in the **Preferences** dialog box (**Word** menu, **Preferences** command). Changing such options affects only the display of the current document when users are working with it in Word X and does not permanently change any formatting in the document.

### Converting Documents to Word X from Other Applications

Users can open files created in a variety of applications and convert them to Word X format. When Word recognizes the file format, it uses the appropriate converter to open the document. Word provides file format converters for the programs listed in the table below and for several text-only file formats.

<table>
<thead>
<tr>
<th>File format</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft Excel 3.x-5.x Worksheet</strong></td>
<td>Use version 3.x Worksheet to open worksheets created in earlier versions of Excel. Use version 5.x Worksheet to open worksheets created in Excel 5.x for the Macintosh or Excel 95 for Windows. These file formats cannot be used to save worksheets.</td>
</tr>
<tr>
<td>Open only</td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Excel 97-2001 Worksheet</strong></td>
<td>Use to open worksheets created in Excel 98 and 2001 for Mac, or Excel 97 and 2000 for Windows. These file formats cannot be used to save worksheets.</td>
</tr>
<tr>
<td>Open only</td>
<td></td>
</tr>
<tr>
<td><strong>Word 97-2001 Import (PCC)</strong></td>
<td>Used by Microsoft PowerPoint® to read Word files.</td>
</tr>
<tr>
<td>Open and Save</td>
<td></td>
</tr>
<tr>
<td><strong>Recover Text Converter</strong></td>
<td>Recovers text from damaged documents.</td>
</tr>
<tr>
<td>Open only</td>
<td></td>
</tr>
<tr>
<td><strong>AppleWorks 5 &amp; 6</strong></td>
<td>Converts AppleWorks 5/6/6 Japanese Word Processing files to Word format. With this converter installed, users can open and edit AppleWorks 5/6/6 Japanese files in Word X. This converter can be used only to open an AppleWorks file. Users cannot save files in AppleWorks format.</td>
</tr>
<tr>
<td>Open only</td>
<td></td>
</tr>
<tr>
<td>File format</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text only</td>
<td>Saves text without its formatting. Converts all section breaks, page breaks, and new line characters to paragraph marks. Uses the ANSI character set. Select this format only if the destination program cannot read any of the other available file formats.</td>
</tr>
<tr>
<td>MS-DOS text</td>
<td>Converts files the same way as text-only format. Uses the extended ASCII character set, which is the standard for MS-DOS-based programs. Use this format to share documents between Word and Windows-based programs.</td>
</tr>
<tr>
<td>Text only with line breaks, MS-DOS text only with line breaks</td>
<td>Saves text without formatting. Converts all line breaks, section breaks, and page breaks to paragraph marks. Use this format when users want to maintain line breaks — for example, when transferring documents to an electronic mail system.</td>
</tr>
<tr>
<td>Rich Text Format (RTF)</td>
<td>Saves all formatting. Converts formatting to instructions that other programs, including compatible Microsoft programs, can read and interpret.</td>
</tr>
<tr>
<td>Web Page</td>
<td>Saves and opens documents in HTML format. Supports all versions up to HTML 3.x, some Microsoft Internet Explorer and Netscape Navigator extensions, and CSS 1.0.</td>
</tr>
<tr>
<td>Unicode Text</td>
<td>Converts text between common character encoding standards, including Unicode 2.0, Mac OS, Windows, EUC, and ISO-8859 series.</td>
</tr>
</tbody>
</table>

An additional converter is available in the Microsoft Office Value Pack for opening Microsoft Works 4.0 files. For information about installing components from the Value Pack, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.
Sharing Documents Among Different Versions of Word

If your organization includes people who use different versions of Word, you can try any or all of the following strategies to allow users to share documents.

Sharing Documents with Versions of Word for Windows

All versions of Word, including Windows versions, are compatible with Word X. Users of Word X can save documents with file name extensions so that Word for Windows users can open the files. Word X users can also easily open Word documents created by Windows users. If users have access to a network share that is connected to both Windows-based and Macintosh OS-based computers, they can place the files on the network and then open them from either type of computer.

Save a document for use with Windows

1. Open the file in Word X, and then click Save As on the File menu.
2. In the Save dialog box, make sure the Append file extension check box is selected.

**Note**  When users select the Append file extension check box, Word changes any file name character that can't be read on a Windows-based computer to an underscore character (_). These characters are the backslash (\), slash mark (/), asterisk (*), angle brackets(< >), and pipe symbol (|).

Open a document created in Word for Windows

1. In Word X, click Open on the File menu.
2. On the Show pop-up menu, click All Readable Documents.
3. Locate and double-click the file you want.

Sharing Documents with Earlier Versions of Word

Word X users can open documents created in previous versions of Word directly in Word X. All data and formatting created in these versions of Word are fully supported in Word X. Word X users can also share templates with users of earlier versions of Word. However, the Word X templates include new and enhanced features that are not available in earlier versions.
People in your organization who are using Word for the Macintosh version 6.x or 5.x can use the Word 97-X Converter to open documents created in Word 98 and later for Macintosh and Word 97 and later for Windows. To install the files, users can open the Value Pack/Shared Applications/Text Converters folder on the Office v. X CD-ROM or on the network installation point, and then drag the Word 97-X Converter Installer file to the Microsoft Office X/Shared Applications/Text Converters folder on their computers.

Users can also save their documents in Word 4.0, Word 5.0, or Word 5.1 for the Macintosh format. When a Word X document is saved in an earlier version of Word, features and formatting available only in Word X won’t be available when the file is opened in the earlier version. However, when the document is saved, Word examines the document and replaces formatting that is not supported by earlier versions with formatting that is supported by those versions. Word displays a dialog box showing what formatting will change in the document. Microsoft Word X saves in the same file format as Word 98 and Word 2001, so no converter is needed to open or save these files.

Note Word 5.x documents cannot be larger than 16 MB (10 MB is recommended). Therefore, a user might receive an error message when saving a large document (for example, one with many graphics) from Word X to the format of an earlier version. If this happens, you can suggest that the user divide the Word X document into smaller files before saving it in the format of earlier versions.

Sharing Documents with Any Version of Word or Other Programs

Rich Text Format (RTF) is a native file format for Word X. When a user saves a Word X document in Rich Text Format, the formatting converts to instructions that earlier versions of Word, and many other word-processing programs, can read.

The advantages of saving documents in Rich Text Format include the following:

- Text and formatting are saved.
- Any version of Word, and many other programs, can read Rich Text Format documents.

The disadvantages of saving documents in Rich Text Format include the following:

- Because the Rich Text Format document type is not the same as the Word Document type, the file name does not appear in the Open dialog box (File menu, Open command) until the user clicks All Readable Documents on the Show pop-up menu.
- Rich Text Format documents increase in size after conversion.
- Password protection is lost.
File Formats in Excel X

A file format determines how information is stored in a workbook. Microsoft Excel X for Mac uses the same file format as Excel 2001 (Mac), Excel 98 (Mac), Excel 2002 (Microsoft Windows), Excel 2000 (Windows), and Excel 97 (Windows). Users of all of these versions of Excel can share workbooks without installing special converters. This section describes strategies for sharing workbooks among users within an organization, including those who do not have Excel installed on their computers.

List Manager Objects in Excel X

The List Manager is a Mac-only feature in Excel X and Excel 2001. List objects that are maintained by the List Manager in Excel X are simple databases consisting of rows and columns (which represent records and fields, respectively) contained within a list frame. The List Manager makes it easy to keep lists separate, maintain data integrity, and find data.

A list object can be created from data in a Microsoft Excel workbook or from data imported from an external data source. Once a list object has been created, it can also be used as the basis for creating a PivotTable.

Workbooks that contain list objects can be opened in Excel versions 97 and later without any data loss. However, because earlier versions of Excel do not have the List Manager feature, list objects are converted to flat data tables and the list management tools provided by the List Manager feature are unavailable. Users can edit the data contained in list objects in earlier versions of Excel and save their workbooks. When the workbook is opened again by using Excel X or Excel 2001, the List Manager features are again available.

Converting Workbooks to Excel X from Earlier Versions of Excel

Your users can open files created in earlier versions of Excel directly in Excel X. All data, formulas, and formatting created in earlier versions are supported by Excel X, with the exception of sound notes in cells. Some macros might not work in Excel X; see the following sections to learn about issues that might affect your users.

Upgrading from Excel 98 or 2001

Microsoft Visual Basic for Applications macros created in Excel 98 or Excel 2001 will run in Excel X.
Upgrading from Excel 4.0 or 5.0

In most cases, users upgrading from Excel 4.0 or Excel 5.0 will not need to change their Excel 5.0 Visual Basic for Applications and Excel 4.0 XLM macros to run them in Excel X. Check the following issues if your users have trouble running or creating macros.

Running Macros

Macros that make calls to custom 16-bit DLLs  The DLL source code must be recompiled into a PowerPC version before the macros will run in Excel X.

Macros created in Japanese version of Excel 5.0  The workbooks will open as read-only and the macros will not run. To open such workbooks in Excel X, users must install the VBA Converter. Installing the converter will also allow users to save macros created in Excel 5.0 if they are using a Japanese version of Excel X or have Japanese set as the language in Mac OS X (System Preferences, International pane, Language tab).


Macros created in non-English versions of Excel 5.0  Users must install the type library for the appropriate language to translate and open these macros in Excel X. Excel type libraries for Danish, Dutch, French, German, Italian, Japanese, Norwegian, Portuguese, Spanish, and Swedish can be installed from the Value Pack. For more information about installing components from the Value Pack, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.

Creating Macros

To create new VBA macros in Excel X, users can record them or write them by using Visual Basic Editor or REALbasic Editor. For more information about recording macros, see Microsoft Excel Help.

Users cannot record new XLM macros in Excel X. However, users can still run and modify XLM macros. For information about XLM macro functions, including syntax and examples, you can download the Excel 4.0 Macro Reference from the Mactopia Web site at http://www.microsoft.com/mac/products/office/2001/excel/excel_main.asp?embfname=macro.asp.

Excel X provides a replacement for the custom dialog box tools in Excel 4.0 (Dialog Editor) and Excel 5.0 (dialog sheets). Users can use the UserForm command on the Insert menu in Visual Basic Editor to create new custom dialog boxes. For more information about creating custom dialog boxes with User Forms, see Visual Basic Help in Visual Basic Editor.
Using Files from Other Applications in Excel X

Users can convert files created in a variety of applications by opening them in Excel X and saving them in the Microsoft Excel X workbook format. When Excel X is installed, several file format converters are installed. Additionally, the Works converter can be installed from the Value Pack. For more information about installing components from the Value Pack, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.

**Note** After the Works converter is installed, Works does not appear on the Show pop-up menu of the Open dialog box (File menu, Open command). However, users can click All Readable Documents on the Show pop-up menu, click the file they want, and then click Open.

AppleWorks Files

Use MacLinkPlus Deluxe (http://www.dataviz.com) to convert files from AppleWorks 6 format to Excel format. Microsoft Excel and AppleWorks 6 display the results of formulas in worksheets, but, in Excel, users can display the formulas within the cells instead of the results. To display formulas, users can click Preferences on the Excel menu, click View, and then select the Formulas check box under Window options. After users open a converted AppleWorks 6 file in Excel, they can examine the relationships of the cells and formulas by using the worksheet audit commands. For more information about auditing worksheets, see Microsoft Excel Help.

FileMaker Pro Files

To convert a FileMaker Pro database to Excel X, a user's computer must have FileMaker Pro installed. The user opens the database by clicking FileMaker Pro Files on the Show pop-up menu in the Open dialog box. After FileMaker Pro starts, the Excel FileMaker Import Wizard appears. By using the wizard, the user can specify which fields to import and describe criteria that can reduce the number of records returned. After the file is converted to Excel, no link is maintained to the original FileMaker Pro file. FileMaker Pro files that are opened in Excel X will be saved in the Excel X file format.

Excel X will truncate the portions of an imported FileMaker database that exceed 256 fields (columns), 65,535 records (rows), or the contents of any record that exceeds 32,767 characters. If users import a FileMaker database that exceeds any of these limits, Excel X should display an alert, but sometimes it does not. For additional information on this issue, read the article Import FileMaker Pro files into Excel X on the Mactopia Web site at http://www.microsoft.com/mac/excelx/excelx_main.asp?embfpath=featartx&embfname=xl_importFileMaker.asp.
Your users can also create an Excel workbook that remains linked to a FileMaker Pro database. In that case, the link to the FileMaker Pro database is maintained, and changes the user makes to the database are updated in the Excel workbook. For more information, see Importing Data from a FileMaker Pro Database on page 85.

### Files from Other Spreadsheet Applications and Databases

Excel also includes converters for files created in other applications. When files in any of these formats are opened in Excel X, they will be saved in their original format. Your users can save these files in the Excel X file format by clicking Save As on the File menu and then clicking Microsoft Excel workbook on the Format pop-up menu.

<table>
<thead>
<tr>
<th>Format</th>
<th>Application</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBF 2, DBF 3,</td>
<td>dBASE II, III, and IV</td>
<td>Opens and saves only the active worksheet.</td>
</tr>
<tr>
<td>DBF 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKS</td>
<td>Microsoft Works version 2.0 for Windows and</td>
<td>Opens only Microsoft Works version 2.0 for Windows or Microsoft Works for MS-DOS spreadsheets. To open a file from a later version of Works, users can open the file in Works and save it as an Excel or dBase file, and then open the file in Excel X.</td>
</tr>
<tr>
<td></td>
<td>Microsoft Works</td>
<td></td>
</tr>
<tr>
<td></td>
<td>for MS-DOS</td>
<td></td>
</tr>
<tr>
<td>WK1, WK3,</td>
<td>Lotus 1-2-3</td>
<td>Applies the formatting in the associated FMT, FM3, or ALL file to WK1 or WK3 files opened in Excel X. If the user saves a Lotus 1-2-3 file in Excel format, Excel X saves the spreadsheet data and formatting in a single workbook file. Lotus 1-2-3 files that are opened in Excel X will be saved in the Lotus 1-2-3 file format.</td>
</tr>
<tr>
<td>FMT, FM3,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Sharing Workbooks Among Different Versions of Excel

If people in your organization use different versions of Excel, you can try either or both of the following strategies to allow them to share workbooks.

Saving Files in an Earlier Version
Excel X, Excel 2001, and Excel 98 users can save their workbooks in formats that allow users of earlier versions of Excel to open and edit the workbooks. When a workbook is saved in an earlier version of Excel, features and formatting available only in Excel X won't be available when the file is opened in the earlier version. However, when the workbook is reopened in Excel X, the unique features and formatting become available again.

To see a list of previous versions of Excel that users can use to save a compatible workbook, click the Format pop-up menu in the Save dialog box (File menu, Save As command).

Users who share workbooks only occasionally can save individual files in a compatible format when necessary by selecting a format on the Format pop-up menu when they save an individual workbook. However, users who share workbooks regularly might prefer to change the default file format for saving workbooks so that every workbook is automatically saved in a compatible file format. For information about changing the default file format, see Setting the Default File Format for Excel Workbooks on page 19.

The Dual File Format
If Excel 5.0 or Excel 95 is widely used in your organization, users can save their Excel X workbooks in a special dual file format. When a user saves a workbook in the Microsoft Excel 97/2002, X & 5.0/95 Workbook format, the workbook is saved as a single file that includes both the Microsoft Excel 97/2002/X, and Excel 5.0/95 file formats. Users of Excel X can continue to work in a workbook saved in the dual format without losing any features or formatting unique to this version. When users of Excel 5.0 or Excel 95 open the workbook, Excel displays a message recommending that they use the file in read-only mode. However, if users ignore the recommendation and save the workbooks in an earlier version of Excel, the features and formatting available only in Excel X are lost. Workbooks saved in the dual file format are larger than those saved in a single format.
File Formats in PowerPoint X

A file format determines how information is stored in a presentation. Microsoft PowerPoint® X for Mac uses the same file format as PowerPoint 2001 (Mac), PowerPoint 98 (Mac), PowerPoint 2002 (Microsoft Windows), PowerPoint 2000 (Windows), and PowerPoint 97 (Windows). Users of all of these versions of PowerPoint can share presentations without having to install special converters. This section describes strategies for sharing presentations among users within an organization, including those who do not have PowerPoint installed on their computers.

Converting Presentations to PowerPoint X from Earlier Versions of PowerPoint

Users can open presentations created in most earlier versions of PowerPoint directly in PowerPoint X. Data and formatting created in earlier versions of PowerPoint are supported in PowerPoint X. PowerPoint X cannot open files created with PowerPoint 3.0 or 4.0. Users can work with PowerPoint 3.0 or 4.0 files in PowerPoint X by opening the files in a version of PowerPoint later than PowerPoint 4.0 and earlier than PowerPoint X, and then saving the files.

Saving Presentations in an Earlier Version of PowerPoint

Users of the following versions of PowerPoint can open PowerPoint X presentations without using any special converters: PowerPoint 2001, PowerPoint 98, PowerPoint 2002, PowerPoint 2000, and PowerPoint 97. PowerPoint X cannot save files in PowerPoint 3.0 or 4.0 format. Users can work with PowerPoint X files in PowerPoint 3.0 or 4.0 by opening the files in a version of PowerPoint later than PowerPoint 4.0 and earlier than PowerPoint X, and then saving the files with the appropriate file format.

Sharing Presentations with PowerPoint for Windows

Macintosh computers and computers running Microsoft Windows might use different fonts. For best results for sharing presentations with Windows users, users should install the additional fonts available in the Value Pack folder on the Microsoft Office v. X CD-ROM. For more information about installing components from the Value Pack, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.
PowerPoint X does not support the new animation effects in PowerPoint 2002 or new animation features such as simultaneous animation and timelines. If a presentation created in PowerPoint 2002 does not look good in PowerPoint X, users can turn off animations by selecting the **Show without animation** check box in the **Set Up Show** dialog box (**Slide Show** menu, **Set Up Show** command).

**Collect Linked Files with PowerPoint Packages**

The new PowerPoint Package option gives users a tool to pack their presentation and all linked files into one folder so they can move the folder to a network share, put it on a disk, or burn it to a CD without losing any of their linked pictures, sounds, movies, hyperlinks, or other files. To save a presentation as a PowerPoint Package, users can click **PowerPoint Package** on the **Format** pop-up menu in the **Save** dialog box.

**Creating PowerPoint Movies**

The PowerPoint Movie format allows users to save a presentation as a QuickTime movie and present it by using any QuickTime-compatible movie player. To save a presentation as a QuickTime movie, users can click **Make Movie** on the **File** menu.

Users can set PowerPoint preferences so that the presentation's text, graphics, and objects are included when it is saved as a PowerPoint movie. That way, users can still open the movie file in PowerPoint X and edit the presentation information embedded in it, just as if it was a normal presentation file. PowerPoint movie preferences can be specified by clicking **Movie Options** on the **General** tab in the **Preferences** dialog box (**PowerPoint** menu, **Preferences** command).

Although PowerPoint movies support many of the features available in PowerPoint X, they have the following limitations:

- PowerPoint Movies can be opened for editing in PowerPoint 2001 for Mac and PowerPoint X for Mac only.
- When users save a PowerPoint Movie to a network volume, all of the slides may come out black. To avoid this problem, users should save the Movie on their hard disks, and then copy the file to a network volume.
- Transparent Graphic Interchange Format (GIF) and Joint Photographic Experts Group (JPEG) images do not appear transparent if they or any other object on the slide is animated.
- Antialiased text loses its antialiasing if the text is animated.
- Animated GIF files are not supported.
• Some animation effects are not supported.
• Chart animations are not supported.
• Inserted sounds do not play through several slides. If a user needs to play a sound during their entire presentation, they can add a background soundtrack in the **Movie Options** dialog box (**File** menu, **Make Movie** command, **Adjust settings**).

For more information about creating presentations that work well as PowerPoint movies, see the article [Optimize presentations for PowerPoint Movies](http://www.microsoft.com/mac/powerpoint/powerpoint_main.asp?embfname=pp_moviestip.asp) on the Mactopia Web site at http://www.microsoft.com/mac/powerpointx/.

### Saving Presentations as Web Pages
PowerPoint X users can save presentations as Web pages, which can then be posted on the Internet or a company intranet. For information, see [Saving Presentations as Web Pages](#) on page 68.

### Using the PowerPoint Viewer
By using Microsoft PowerPoint Viewer 98 for the Macintosh, users can run slide shows on computers that do not have PowerPoint installed. The viewer is available for downloading from the [Mactopia Downloads center](http://www.microsoft.com/mac/download/office98/powerpoint98viewer.asp). Microsoft PowerPoint Viewer 98 for the Macintosh can be freely redistributed. On Mac OS X, the viewer runs in the Classic environment.

**Note** Although PowerPoint Viewer 98 lets users view presentations that were created in PowerPoint X, it does not support playback of certain PowerPoint X features, such as exit animations, graphical bullets, QuickTime transitions, or animated GIFs.

### Web Support in Word X
Microsoft® Word X for Mac supports the Office-wide Web features, such as hyperlinks and the **Web** toolbar. In addition, Word includes authoring tools for creating Web pages. Your users can use their existing knowledge of Word and most of the features in Word immediately — without having to learn or work directly with HTML code. For more information about the Word X Web page authoring features, see Microsoft Word Help.
Saving Documents as Web Pages

Users can save Word documents as Web pages by using the **Save as Web Page** command on the **File** menu. Word provides two options for saving files in HTML format.

**Save entire file into HTML**  Saves all of the document's properties into the HTML file. Users can select this option if their documents contain Word-specific elements, such as comments, header or footer information, or document properties, that the users want to maintain. However, the Word-specific elements won't appear when the document is viewed in a Web browser.

**Save only display information in HTML format**  Saves only the elements and attributes in a Word document that can be displayed in a Web browser. Any document properties that are not supported in HTML, such as line spacing, margins, character spacing, **kerning**, text flow settings, and spacing before and after paragraphs, will be lost. Users can select this option to reduce the size of the HTML file when there is no need to maintain any of the document's Word-specific properties.

When users save a document as a Web page, Word creates the main `filename.htm` file and a companion `filename_files` folder that contains the individual elements of the Web page, such as graphics. To view a Web page in a browser, users can open the main `filename.htm` file. If they move the Web page to another location, they must move the main file and the companion folder together.

Using Web Page Templates

Word X provides several Web page templates to help make the creation of pre-defined Web pages, such as multicolumn pages or personal home pages, quick and easy. Web page templates offer a variety of text formats and graphic images for each type of Web page design. After creating the Web page, users can modify it by using the Word Web page authoring tools. To use one of Word's pre-defined Web page templates, users can click the Web Pages category in the Project Gallery (**File** menu, **Project Gallery** command). To create a plain, blank Web page, they can click Blank Documents in the Project Gallery and then choose the Web Page template.

Documents created from a Web page template are automatically saved as Web pages by default.
Web Support in Excel X

Microsoft Excel X for Mac supports the Web features, such as hyperlinks and the Web toolbar, available throughout Office v. X. In addition, Excel supports importing and exporting HTML documents and Web queries.

Saving Excel Data as a Web Page

Excel workbooks or parts of workbooks, such as a single item on a worksheet, can be saved in HTML format and made available as a Web page on the Internet or an intranet that others can access by using their Web browser. Excel allows users to save Excel data as a Web page on a schedule they set or automatically every time the Excel file is saved. This process can be automated by clicking Save as Web Page (File menu) and then clicking Automate in the Save as Web Page dialog box. Microsoft Entourage must be running at the time the data is scheduled to be saved. The schedule that is run is based on the current identity set in Entourage. For more information about identities, see Identities on page 28.

When Excel X is used to create Web pages, the data is converted to HTML format. Excel X can reopen Web pages created by Excel; however, the pages' properties as workbooks are lost. If a user saves a workbook as a Web page and later needs to go back and change the data, the user should make the changes in the original Excel file and the file should then be re-saved as a Web page.

Excel X does not support saving workbooks or other data directly to a Web server by using FTP or other methods. To share Excel X Web pages, your users must manually post them to a Web server.

For more information about the limitations of saving Excel data as a Web page, see Microsoft Excel Help.
Excel Features Not Supported on the Web

Depending on the type of Microsoft Excel data you are saving as a Web page and how that data is formatted, some features and formatting might not work or appear as you expect them to when data is saved as a Web page.

Spreadsheet functionality

<table>
<thead>
<tr>
<th>Feature</th>
<th>Result on a Web page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared workbook information</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Pattern fills</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Named cells or named ranges</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Named constant values</td>
<td>Converted to values.</td>
</tr>
<tr>
<td>Wrapped text in cells</td>
<td>Displays correctly; however, the settings are not retained in HTML.</td>
</tr>
<tr>
<td>Conditional formatting</td>
<td>Current cell formatting is retained. Formatting is no longer conditional.</td>
</tr>
<tr>
<td>Outlining</td>
<td>Collapsed rows are published as hidden. Expanded rows are published normally.</td>
</tr>
<tr>
<td>Password protection</td>
<td>Data in password-protected worksheets and workbooks can be saved or published as a Web page; however, passwords are not retained in HTML.</td>
</tr>
<tr>
<td>Data validation restrictions and messages</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Precision as displayed</td>
<td>Precision as displayed value is saved; however, the settings are not retained in HTML.</td>
</tr>
<tr>
<td>Array formulas</td>
<td>Converted to values.</td>
</tr>
<tr>
<td>Distributed alignment</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Auditing tracer arrows</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Feature</td>
<td>Result on a Web page</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Indented text</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Printing and page setup features</td>
<td>Not retained.</td>
</tr>
<tr>
<td>Labels in formulas</td>
<td>Converted to values.</td>
</tr>
<tr>
<td>Rotated or vertical text</td>
<td>Converted to horizontal text.</td>
</tr>
<tr>
<td>References to data on other worksheets</td>
<td>References are converted to values.</td>
</tr>
<tr>
<td>1904 date system</td>
<td>The displayed dates remain the same, but the serial numbers for the dates are not retained.</td>
</tr>
<tr>
<td>R1C1 reference style</td>
<td>Converted to values.</td>
</tr>
<tr>
<td>External data ranges</td>
<td>Converted to values. Ability to refresh from the source data is not retained.</td>
</tr>
<tr>
<td>Web queries</td>
<td>Converted to values.</td>
</tr>
<tr>
<td>Subtotals</td>
<td>Converted to values. Formulas are not retained.</td>
</tr>
</tbody>
</table>

**PivotTables**

If users want to make an Excel X PivotTable® report available on the Web, they can save the report in HTML format and publish it as a noninteractive table. PivotTable values and cell formatting are converted and displayed on the Web page. Because the PivotTable report becomes a noninteractive table, it loses its PivotTable functionality to Web users.

**Charts**

Users must save charts on a separate sheet from other data in their workbook to make everything appear correctly on the Web. Charts that are saved as Web pages are converted to graphics.
Web Support in PowerPoint X

Microsoft PowerPoint® X for Mac includes special features designed to let users publish presentations on the Internet or an intranet and add hyperlinks to presentations. This section describes the Web authoring features of PowerPoint.

Saving Presentations as Web Pages

Users can share presentations by saving them as Web pages and then posting them on the Internet or a company intranet. To save a presentation as a Web page, users can click the Save as Web Page command on the File menu.

When a presentation is saved as a Web page, PowerPoint creates the main filename.htm file and a companion filename_files folder that contains the individual elements of a Web presentation (slides, graphics, navigation, and so forth). To view the Web presentation in a browser, the user must open the main filename.htm file. If the Web presentation is moved to another location, the main file and the companion folder must be moved together.

After a presentation is saved as a Web page, it cannot be edited as a PowerPoint presentation. To ensure that users can always edit the original PowerPoint presentation, PowerPoint saves a copy in the companion folder by default. Users can disable this option by clearing the Include the original file with this Web presentation so it can be edited in PowerPoint later check box on the Files tab in the Web Options dialog box (File menu, Save as Web Page command, Web Options button).

When a user saves a presentation as a Web page, he or she can specify options for optimizing the Web page for either of the following Web browsers: Microsoft Internet Explorer 5.X or Netscape Navigator 4.7. If your organization uses one of these Web browsers exclusively, users can reduce the size of the generated files by setting PowerPoint options for optimizing the Web page for that browser. These options can be set by clicking Web Options on the General tab in the Preferences dialog box (PowerPoint menu, Preferences command). On the Files tab, under Browser support, the user can select or clear the check boxes next to the browser options. For example, if the user clears all of the check boxes except Support Internet Explorer browsers, the Web page will be optimized for Internet Explorer 5. If the presentation will be viewed by a wider audience, users should select the Add support for other browsers checkbox. By default, Web presentations are saved with support for all browsers, a setting that results in the largest file sizes.
Presentations saved as Web pages have the following limitations:

- The quality of graphics might go down.
- Slide animations and transitions do not appear.
- Web page file names cannot be longer than 25 characters.
- Bullets and some other characters might not display correctly in Netscape Navigator.

To fix this problem, in Netscape Navigator, on the View menu, click Character Set, and then select Unicode (UTF-8).

Notes

- When a Web page is optimized for use in a particular browser, it becomes unreadable by any other browser. Users should optimize for a particular browser only if they are certain that the Web page will never be opened by a different browser.

- When a user saves a presentation as a Web page, some elements of the original PowerPoint presentation might be lost. For example, some types of action buttons might not work properly. Before distributing such a Web page, users should thoroughly test it in all browsers that might be used for viewing.

Adding Hyperlinks to PowerPoint Presentations

PowerPoint allows users to add hyperlinks to presentations by using the Hyperlink command (Insert menu) or the Hyperlink to option in the Action Settings dialog box (Slide Show menu). Any object on a slide can be made into a hyperlink that, when clicked, takes the user to another slide in the active presentation, another presentation, another file, or a Web page.

Users can also include hyperlinks in a presentation by adding action buttons. Action buttons are graphic images designed to look like buttons. When a user adds an action button to a slide, the Action Settings dialog box appears automatically so the user can specify a destination for the action button.

Users can create hyperlinks for objects, such as AutoShapes and text boxes, and for text strings. Because text in PowerPoint exists within a text object, PowerPoint maintains distinct hyperlinks for a text string and for the text object that contains the string. For example, a text box can have action settings assigned to it, and a text string within the text box can have a hyperlink added to it. For information about adding hyperlinks to presentations, see Microsoft PowerPoint Help.
Workgroup Features in Word X

Microsoft® Word X for Mac includes several features that support group review of documents. If your workgroup has access to e-mail, users can also send documents to their coworkers.

Creating a Document with Many Authors

Word provides a number of features that are especially useful when several members of a workgroup jointly write long documents. Your users can use these features in the following ways:

• Use master document view to create a group of subdocuments and compile them into a single long document. To enable master document view, users can click Master Document on the View menu.

    When the document is printed, Word combines all of the subdocuments and automatically numbers pages, lines, and footnotes in sequence. Word can generate a table of contents, a table of illustrations, an index, and cross-references for the master document. Word can also use fields to create captions for illustrations and to number items (such as tables of figures) in series.

• Use templates to ensure that all documents have the same layout and boilerplate text and graphics. To attach templates to documents, users can click Templates and Add-Ins on the Tools menu.

    Templates also allow users to provide customized features, such as additions to toolbars and menus, special key assignments, and macros.

• Use styles to ensure consistent formatting and make it easy to change documents quickly. Users can take advantage of the built-in heading styles in Word to quickly create tables of contents and document outlines. To define and apply styles, they can click Style on the Format menu.

• Use bookmarks to quickly locate text and create cross-references to other parts of a document. To insert a bookmark, users can click Bookmark on the Insert menu.

• Use AutoText entries to store frequently used text and graphics and quickly insert them into documents without retyping or copying and pasting. To create or insert an AutoText entry, users can point to AutoText on the Insert menu.

• Use document map view to quickly browse a long document and see its outline structure and content side-by-side. To turn on the document map, users can click Document Map on the View menu.
For more information about using these features, see Microsoft Word Help.

The remainder of this section describes other features to use when several members of a workgroup jointly write or review Word documents.

**Tracking Changes**

The commands on the **Track Changes** submenu (**Tools** menu) allow reviewers to make revisions to a document. The author of the document can then accept or reject these revisions. The author or any reviewer can specify how revisions should appear (for example, whether deleted text should be formatted as strikethrough or hidden) under **Track Changes** in the **Preferences** dialog box (**Word** menu, **Preferences** command).

**Adding Comments**

Comments in a Word document are analogous to reviewer notes written in the margins of a printed document. Users can insert a comment by clicking the **Comment** command (**Insert** menu) and then typing the comment in the comments pane below the document. Word formats the comment indicator and the preceding word or range of selected text with a yellow background, so the comment and the text to which it refers are clearly visible.

Users, including the author and all reviewers, can then view the comment by resting the pointer on the yellow-highlighted text or over the comment indicator.

**Tip** Comments are especially useful when used with change tracking. When making a change to a document, a reviewer can also insert a comment that explains why the change is necessary.

**Saving and Comparing Different Versions of Documents**

Word supports two ways of working with different versions of documents: saving versions of a document in a single file and comparing differences between different documents.

**Saving Document Versions**

Version control lets Word users save multiple versions of a document within a single file. For example, users can save the first draft of a document, save the edited version of the document, and then save the final version after the document has been polished for publication. All three versions are saved within the document file, but only one version is active at any given time. Version control is available through the **Versions** dialog box (**File** menu, **Versions** command).
Recorded with each version are the name of the author who last saved the version of the document, the date and time it was saved, and any additional comments the author included. In the Versions dialog box, users can switch between versions of a document or delete versions.

Saving versions of a document in this way is similar to saving a document to different file names at different times. For example, a user might start with the draft document Mydocument1, save it after editing as Mydocument2, and then save it again before distribution as Mydocument3. Saving multiple versions in the same file is more efficient, however: Word saves only the differences between versions, so less disk space is used, and the user can more easily switch between versions. Version control is also a useful tool to help maintain a clear record of revisions to a document such as a legal contract.

Comparing Documents

The Compare Documents command (Tools menu, Track Changes command) lets users see the differences between two documents. When Compare Documents is clicked, Word prompts the user to select a document to compare with the active document. Word then indicates differences between the two by making revisions to the active document with change marks. The user can then review the revisions and accept or reject them.

Unlike version control, the compare documents feature requires two documents to compare. Users who are using version control and want to compare two versions of a document must first save one of the versions as a separate document. To do so, they can switch to the other version of the document by clicking Versions (File menu), and then save it with a different file name by clicking Save As (File menu). The Compare Documents command can then be used to compare the two documents.

Merging Documents

By using the Merge Documents command (Tools menu), users can combine tracked changes from several documents into one document. Unlike the Compare Documents command (Tools menu, Track Changes command), the merge documents feature requires that change tracking be turned on and that the documents be identical except for tracked changes.
Sending Documents by Using E-mail

Workgroup members who have e-mail capability can review documents by clicking the Mail Recipient (as Attachment) command (File menu, Send To command) to send the document as an e-mail attachment.

To send documents by using e-mail, a user must have one of the following e-mail applications installed on his or her computer:

- Microsoft Entourage™ X
- Eudora for Mac OS X
- Mail

Notes

- Users cannot send documents from Word if their default e-mail program runs in the Classic environment.
- Sending documents in e-mail might not work across electronic mail gateways.
- If users are sending a document to someone who uses Microsoft Office for Windows, they should add the file extension to the end of the file name. They can add the extension when they save their document by selecting the Append file extension check box in the Save As dialog box.
Security Features in Word X

Word X security features can help your users protect information that is shared over your network or the Internet.

Protecting Word Documents

Microsoft Word supports three levels of document protection. The user who creates a document has read/write permission to a document and controls the protection level. Users can set passwords for these protection levels under Save in the Preferences dialog box (Word menu, Preferences command) or by clicking Options on the Save dialog box. The three levels of protection are:

- **File open protection** Word requires the user to enter a password to open a document.
- **File modify protection** Word requires the user to enter a password to open the document with read/write permission. If the user clicks Read Only at the prompt, Word opens the document as read-only.
- **Read-only recommended protection** Word prompts the user to open the document as read-only. If the user clicks No at the prompt, Word opens the document with read/write permission, unless the document has other password protection.

In addition to protecting an entire document, users can also protect specific elements from unauthorized changes by using the Protect Document command (Tools menu). This method is not as secure as using a password to protect the entire document, because Word does not use encryption when users protect only specific elements. For example, field codes can be viewed in a text editor even if forms or sections of a document are protected.

The specific document elements that users can protect include the following:

- **Tracked changes** Changes made to the document can be neither accepted nor rejected, and change tracking cannot be turned off.
- **Comments** Users can insert comments into the document but cannot change the content of the document.
- **Forms or sections** Users can make changes only in form fields or unprotected sections of a document.

**Caution** If a user assigns password protection to a document and then forgets the password, you cannot open the document, gain access to its data in another document through links, remove protection from the document, or recover data from the document. Advise your users to keep a list of passwords and corresponding document names in a safe place.
Using Documents That Contain Digitally Signed Macros

Microsoft Word X does not recognize digital signatures, so it cannot update the signature if a user modifies a signed Microsoft Visual Basic® for Applications macro. Therefore, to prevent modifications, users cannot view in Word X the code for macros that have been digitally signed in Word 2000 or Word 2002 for Microsoft Windows®.

Workgroup Features in Excel X

Microsoft Excel X for Mac enables users to collaborate and share workbooks. This section explains how to administer features in Excel X that are designed for sharing workbooks among users in a workgroup. It describes how the various workgroup features of Excel work and provides information for supporting them.

Shared Workbooks

Excel allows many users to edit the same workbook simultaneously or edit copies of a workbook at different times. In both cases, a user with read-write access to the workbook can share the workbook by clicking Share Workbook (Tools menu). This section describes shared workbooks — multiple users editing the same workbook simultaneously. For information about workbook merging — users editing copies of a workbook at different times — see Workbook Merging and Data Consolidation on page 78.

When a workbook is shared, Excel X keeps a change history of the workbook. The change history records who changes cells, when a change is made, and what the previous values of an edited cell were.

Shared workbooks have the following characteristics:

- Not all Excel commands and features are available. For example, users cannot delete a sheet in a shared workbook. For a complete list of limitations when using shared workbooks, see Microsoft Excel Help.

- Not all of the commands and features that are available when working with a shared workbook are recorded in the change history. For example, formatting changes are allowed in a shared workbook, but they are not recorded in the change history. For a list of limitations of change highlighting, see Microsoft Excel Help.
• Users can specify how long the history of cell revisions is maintained by setting the **Keep change history for** time value on the Advanced tab in the Share Workbook dialog box (Tools menu). Each time the workbook is closed, Excel deletes any part of the stored change history that is older than the number of days specified.

• To protect the change history of a shared workbook, users must click **Protect and Share Workbook** (Tools menu, Protection command). For more information about workbook protection, see **Security Features in Excel X** on page 80.

**Note** When a user turns off workbook sharing, the entire change history is cleared. Once cleared, the change history cannot be recovered.

**Tip** A workbook for which the change history has been enabled grows in size as the change history grows. To conserve disk space, you can shorten the **Keep change history for** time period, or you can enable sharing without enabling the change history. On the Advanced tab in the Share Workbook dialog box (Tools menu, Share Workbook command), under **Track changes**, click **Don't keep change history**.

Some common uses of shared workbooks include:

• Sharing a schedule among several users. For example, you can keep a master schedule for employees to record their working hours. In this case, different users might need access to any part of the workbook at any time.

• Consolidating data stored on different worksheets within a single workbook. For example, different department managers might maintain their budgets on departmental sheets in a workbook, and a division vice president might consolidate the data onto another sheet in the workbook with the **Consolidate** command (Data menu).

• Summarizing data stored on different rows within a single worksheet. For example, different department managers might keep track of personnel headcount on specific rows in a worksheet, and a division vice president might summarize the data — perhaps applying an outline and subtotals or averages.

When two or more users of a shared workbook make conflicting changes (for example, entering different values in the same cell), users can either review the conflicts or automatically save their own changes when they save the workbook. Users set this option for themselves in the **Conflicting changes between users** area on the Advanced tab in the Share Workbook dialog box (Tools menu, Share Workbook command).
Workgroup Review of Workbooks

Excel includes features that support adding comments and tracking changes to workbooks. If your workgroup has access to e-mail, users can also send workbooks to their coworkers directly from Excel.

Tracking Changes and Comments

As with Microsoft Word documents or Microsoft PowerPoint® presentations, it is common for many members of a workgroup to revise or annotate an Excel workbook.

The Track Changes commands (Tools menu) allow your users to record, review, accept, or reject changes to cell values. When users click Highlight Changes (Tools menu, Track Changes command), Excel turns on both change history (if it was not already on) and workbook sharing. All changes to cell values are recorded and indicated by a small triangle in the upper-left corner of changed cells. The triangles are color coded to distinguish between different users. Pointing to such a cell displays the change history box, which displays the most recent change made to that cell.

Viewing the Entire Change History

The change history box of a cell shows only the most recent change made to the cell. To see all changes in the change history, users can select the List changes on a new sheet check box in the Highlight Changes dialog box (Tools menu, Track Changes command). Selecting this option adds a History sheet to the shared workbook that lists all changes recorded in the change history. The list is filtered, so users can easily review all changes that have been made to any cell.

To review the recorded changes, users can click the Accept or Reject Changes command (Tools menu, Track Changes command). This starts a process similar to reviewing revisions in Word: Users can review each change made to the worksheet, and accept or reject each one.

Comments can also be recorded for any cell in a workbook. To create a comment, users click the Comment command (Insert menu). A cell that contains a comment has a small red triangle in the upper right corner. Pointing to the cell displays the cell comment in a box.
Workbook Merging and Data Consolidation

Workbook merging and data consolidation have similar purposes: Both start with data from multiple sources and end with a summary of the data in a single workbook.

Workbook Merging

Workbook merging is similar to working with shared workbooks, but instead of multiple users editing the same workbook simultaneously, multiple copies of a single workbook are reconciled. As with shared workbooks, merging requires the change history to be turned on with the Share Workbook command (Tools menu) before making copies and distributing the workbook. It is better suited for workbooks in which multiple contributors edit any part of the data at any time, or in which a single user edits different versions of the same workbook on different computers. For example, a mobile user might copy a shared workbook to a laptop computer. While the user is gone, other users can continue to edit the shared workbook. Upon returning, the mobile user can merge changes into the original workbook.

The change history must be turned on in the workbook from the time copies of the workbook are created to the time changes are merged back into the original workbook. Users can specify the duration of the change history on the Advanced tab in the Share Workbook dialog box (Tools menu). Unless the change history of the workbook is protected, a user can turn it off. If this happens, that user's changes cannot be automatically merged. To protect the change history, use the Protect and Share Workbook command (Tools menu, Protection command). To merge workbooks, use the Merge Workbooks command (Tools menu).

For more information about workbook protection, see Security Features in Excel X on page 80.

Data Consolidation

Data consolidation combines data stored in multiple workbooks. It is designed for summarizing structured data, such as rolling up departmental budgets into a summary budget for a division.

Data consolidation is similar to workbook merging, but it does not necessitate turning on the change history. Use data consolidation to compile repetitive, highly structured data from several subordinate workbooks or worksheets into one summary workbook.
When data is consolidated on multiple worksheets within one workbook, use consolidation by 3-D references and share the workbook. A 3-D reference includes a cell or range reference, preceded by a range of worksheet names, allowing you to analyze data in the same cell or range of cells on multiple worksheets within a workbook. Use 3-D formulas on the consolidation worksheet to refer to the data sources on the detail worksheets.

If 3-D references are not used, consolidate data by consistent positions on a worksheet or by the category of data. Whether 3-D references or position or category references are used, start consolidating data by clicking the Consolidate command on the Data menu.

Sending Workbooks by Using E-mail

Users in a workgroup who have e-mail capability can review workbooks by using the Mail Recipient (as Attachment) command (File menu, Send To command) to send the workbook as an e-mail attachment.

To send workbooks by using e-mail, a user must have one of the following e-mail applications installed on his or her computer:

- Microsoft Entourage X
- Eudora for Mac OS X
- Mail

Notes

- Users cannot send workbooks from Excel if their default e-mail program runs in the Classic environment.
- Sending workbooks in e-mail might not work across electronic mail gateways.
- If users are sending a workbook to someone who uses Microsoft Office for Windows, they should add the file extension to the end of the file name. They can add the extension when they save their workbook by selecting the Append file extension check box in the Save As dialog box.
- If a user is sending a workbook to someone who has not yet upgraded to Excel X, the user should first save the workbook in a format that the target version of Excel can open, such as Excel 5.0 format. For information about sharing workbooks among different versions of Excel, see Sharing Workbooks Among Different Versions of Excel on page 60.
Security Features in Excel X

Excel X security features can help you protect information that is shared over your network or the Internet.

Protecting Excel Worksheets

Microsoft Excel supports three levels of workbook file protection. The user who creates a workbook has read/write permission to a workbook and controls the protection level. Users can set passwords for these protection levels by clicking Options on the Save dialog box. The three levels of workbook protection are:

- **File open protection**  Excel requires the user to enter a password to open a workbook.

- **File modify protection**  Excel requires the user to enter a password to open the workbook with read/write permission. The user can click Read Only at the prompt, and Excel opens the workbook as read-only.

- **Read-only recommended protection**  Excel prompts the user to open the workbook as read-only. If the user clicks No at the prompt, Excel opens the workbook with read/write permission, unless the workbook has other password protection.

Excel encrypts password-protected workbooks by using the symmetric encryption routine known as 40-bit RC4. For more information about encryption and security in Excel, see Microsoft Excel Help.

**Note**  Some workbook protection and encryption features vary depending on the language of the operating system they were created in. Before you can open a protected workbook, you must unprotect it by using the same operating system and language in which it was created.

In addition to protecting an entire workbook, specific elements can be protected from unauthorized changes by using the Protect Sheet and Protect Workbook commands (Tools menu). This method is not as secure as using a password to protect the entire workbook because Excel does not use encryption when you protect only specific elements. For example, cells that are hidden on a protected worksheet can be viewed if a user copies across a range on the protected worksheet that includes the hidden cells, opens a new workbook, pastes, and then uses the Unhide command to display the cells.

**Tip**  To ensure the strongest security on a workbook, use a password to protect the entire workbook.
The specific elements that you can protect in a workbook include the following:

- **Structure of a workbook**  Worksheets and chart sheets in a protected workbook cannot be moved, deleted, hidden, unhidden, or renamed, and new sheets cannot be inserted.

- **Windows in a workbook**  Windows in a protected workbook cannot be moved, resized, hidden, unhidden, or closed. Windows in a protected workbook are sized and positioned the same way each time the workbook is opened.

- **Cells on a worksheet or items on a chart sheet**  Contents of protected cells on a worksheet cannot be edited. Protected items on a chart sheet cannot be modified.

- **Graphic objects on a worksheet or chart sheet**  Protected graphic objects cannot be moved or edited.

- **Formulas on a worksheet**  Protected formulas cannot be edited.

- **Scenarios on a worksheet**  Definitions of protected scenarios cannot be changed.

- **Change histories of shared workbooks**  Protected change histories cannot be cleared by the user of a shared workbook or by the user of a copy of a workbook that is to be merged.

**Caution**  If a user assigns password protection to a workbook and then forgets the password, you cannot open the workbook, gain access to its data in another workbook through links, remove protection from the workbook, or recover data from the workbook. Advise your users to keep a list of passwords and corresponding workbook, worksheet, and chart sheet names in a safe place.

**Using Worksheets that Contain Digitally Signed Macros**

Microsoft Excel X doesn't recognize digital signatures, so it can't update the signature if you modify a signed Microsoft Visual Basic for Applications macro. Therefore, to prevent modifications, you cannot view in Excel X the code for macros that have been digitally signed in Excel 2002 or Excel 2000.
Workgroup Features in PowerPoint X

Users of Microsoft PowerPoint® X for Mac can collaborate by sending presentations to their coworkers directly from PowerPoint. As a presentation is circulated for review by a workgroup, individual users can add their comments to it.

Sending Presentations by Using E-mail

Users in a workgroup who have e-mail capability can send a presentation to others for review by attaching it to an e-mail message.

To send presentations by using e-mail, a user must have one of the following e-mail applications installed on his or her computer:

- Microsoft Entourage X
- Eudora for Mac OS X
- Mail

Notes

- Users cannot send presentations from PowerPoint if their default e-mail program runs in the Classic environment.
- Sending presentations in e-mail might not work across electronic mail gateways.
- If users are sending a presentation to someone who uses Microsoft Office for Windows, they should add the file extension to the end of the file name. They can add the extension when they save their presentation by selecting the Append file extension check box in the Save As dialog box.
- If users are sending presentations to coworkers who do not have PowerPoint X installed, the presentations should be saved in a format that the recipients can view. For information about saving presentations in different formats, see File Formats in PowerPoint X on page 61.

To send a presentation, a user can point to Send To on the File menu and then click Mail Recipient (as Attachment). A new message appears with the presentation attached. The user can simply address the message to recipients who need to review the presentation, and then send it.
Adding Comments to Presentations

Each member of a workgroup can review a presentation and add comments directly on the slide that the comment pertains to. To add a comment on a slide, the user can click **Comment** on the **Insert** menu and then type a comment in the text box that appears.

Comments are text objects with unique formatting. To differentiate comments, each reviewer in the workgroup can use a different format or shape. The default formatting of the object can be changed by using the **Comment** command (**Format** menu). The shape of the object can be changed by clicking **Change AutoShape** on the **Drawing** toolbar.

Users can show or hide comments in a presentation by clicking the **Comments** command (**View** menu).

Sharing Word Information with Other Office Applications

Microsoft® Word X for Mac allows users to share information between both Microsoft Excel and Microsoft PowerPoint®. This section describes some of the features for sharing information with other Office applications.

Importing Workbooks from Microsoft Excel

Word X provides several ways to insert Excel data into a Word document. For example, users can easily copy and paste a worksheet or chart. They can also insert the worksheet or chart as a linked object or embedded object.

**Linked workbooks** A linked worksheet or chart appears in the document, but its information is stored in the original Excel workbook. Whenever the data is edited in Excel, Word automatically updates the worksheet or chart in the document. Linking is useful in including information that is maintained independently, such as data collected by a different department, and when the information in Word must be kept up-to-date. Because the linked data is stored in another location, linking can also help minimize the file size of the Word document.

**Embedded workbooks** An embedded worksheet or chart stores its information directly in the Word document. An embedded object can be an existing Microsoft Excel worksheet or chart, or users can create a new embedded Microsoft Excel worksheet or chart. To edit the embedded object, users can just double-click it to start Excel, make any changes, and then return to Word. Because the information is totally contained in one Word document, embedding is useful in distributing an online version of a document to people who do not have access to independently maintained worksheets or charts.
Sharing Data with PowerPoint Presentations

Word provides several ways to insert Microsoft PowerPoint data into a Word document. For example, users can easily copy and paste text, graphics, or entire slides.

Users can also create a new presentation in PowerPoint by first creating an outline in Word and then using the Microsoft PowerPoint command (File menu, Send to command) to send the outline to PowerPoint. Word exports the heading level paragraphs to PowerPoint. The Word document opens in PowerPoint as a new presentation in normal view. After the outline is exported, additional text can be added to the presentation in PowerPoint, but there is no link back to the outline in the original Word document.

If the paragraphs are formatted as heading styles in Word, PowerPoint structures the presentation outline according to the heading styles. Every Heading 1 paragraph becomes the title for a new slide, a Heading 2 paragraph becomes the first level of text, and so forth. Text formatted as anything other than a heading style is not imported to the presentation. If the paragraphs are not styled with heading styles, PowerPoint structures the presentation outline according to the way the paragraphs are indented.

Sharing Contact Information with Entourage

The Office Address Book provides a convenient place to store e-mail addresses, home and work addresses, and phone and fax numbers. In the Office Address Book, each entry—or collection of information about a person—is called a contact. Users can view, modify, and add individual contacts in the Office Address Book while working in Microsoft Word. When users update contact information directly in a document, they can also update the Office Address Book at the same time. If users make changes to the Office Address Book in Word, their changes will also appear in the Microsoft Entourage™ Address Book.

The information users enter when they set up Microsoft Office v. X (or Microsoft Word X) also appears as their personal contact information in the Office Address Book. Word uses this information to generate a return address on envelopes, labels, and in the wizards that help the user create letters and other kinds of documents. Users' personal contact information also appears when they open the business templates found in the Project Gallery or insert comments in documents, as well as in the File Properties of every Word document they create.
Users can update their personal contact information in the following ways:

- Open the Office Address Book (Tools menu), and make changes.
- Enter changes in User Information in the Preferences dialog box (Word menu, Preferences command).
- If Microsoft Entourage is installed on the computer, open the Entourage Address Book and make changes.

If users share a computer with others, they can ensure that Word uses their personal contact information by logging on to the computer using their own logon information, or by switching identities in Entourage (if it's installed on the computer). For more information about identities, see Microsoft Entourage Help.

**Importing Information in Excel X**

Microsoft Excel X for Mac has several features that allow you to manage data and connect to various data sources. This section describes some of the features that let you and your users maintain and share data in Excel.

**Importing Data by Using Open Database Connectivity (ODBC)**

ODBC support is not included with Excel X. For the latest information on ODBC support, visit the Mactopia Web site at http://www.microsoft.com/mac/.

**Importing Data from a FileMaker Pro Database**

Excel X provides a FileMaker Import Wizard that you can use to import or convert FileMaker Pro databases to Excel. The FileMaker Import Wizard is available only to users who have FileMaker Pro installed.

When users access a FileMaker Pro database in Excel by clicking Open on the File menu, the FileMaker Import Wizard starts and allows them to convert their data so that they can maintain it in Excel. There are some limitations on importing data from a FileMaker database into an Excel workbook. For more information, see Using Files from Other Applications in Excel X on page 58.

Users can also use the FileMaker Import Wizard to set up a query to a FileMaker Pro database. By clicking Import from FileMaker Pro (Data menu, Get External Data command), they can bring data from the database into Excel without having to convert the database. They can maintain the data in FileMaker Pro and update it in the Excel workbook by clicking Refresh Data on the Data menu.
Importing and Refreshing Data from a Text File

Data from text files can be brought into Excel in the same way that a user creates other database queries. Formatting and formulas are retained when the user opens the file as refreshable. By clicking Import Text File (Data menu, Get External Data command), the user starts the Text Import Wizard and is then able to create an External Data Range. This query is similar to a regular database query and can be used to retrieve and refresh data from the original text file. For more information about refreshing external data, see Microsoft Excel Help.

Using Web Queries in Excel X

A Web query retrieves data stored on the Internet or an intranet. For example, you can create a Web query that retrieves a current product price from a database on your intranet. Excel X includes sample Web queries that you can modify by changing the text in any text editor. You can find these samples in Microsoft Office X/Office/Queries. To retrieve external data from a Web source, users must have access to the Internet or an intranet, depending on the location of the data source. Users can run a Web query by clicking Run Saved Query (Data menu, Get External Data command), locating the query they want to run in the Choose a Query dialog box, and then clicking Get Data.

Sharing PowerPoint Information with Other Office Applications

Microsoft PowerPoint X for Mac allows users to share information with both Microsoft Excel X for Mac and Microsoft Word X for Mac. This section describes some of the features for sharing information with other Microsoft Office v. X for Mac applications.

Importing Outlines from Word

Users can import a document created in Word and use it as the outline for a PowerPoint presentation. PowerPoint determines the outline structure for the presentation based on the paragraph formatting of the imported document, as follows:

By heading styles If the paragraphs are formatted as heading styles in Word, PowerPoint structures the presentation outline according to the headings. Each Heading 1 becomes the title for a new slide, each Heading 2 becomes the first level of text, and so forth. Text formatted as anything other than a heading style is not imported to the presentation.

By indented paragraphs If the paragraphs are not formatted with heading styles, PowerPoint structures the presentation outline according to how the paragraphs are indented. Each paragraph that is aligned with the left margin becomes the title for a new slide, paragraphs that are indented once become the first level of text, and so forth.
By leading tabs  If the paragraphs are indented with leading tabs — as in a plain text file — PowerPoint uses the number of leading tabs to determine the outline structure. Each paragraph with no leading tabs becomes the title for a new slide, each paragraph with one leading tab becomes the first level of text, and so forth.

Note  PowerPoint supports five levels of text outlining; outline levels six and greater are imported as level-five text in PowerPoint.

Tip  Users can also import outlines from other word processing applications or from an HTML document.

For information about creating a presentation by importing an outline, see Microsoft PowerPoint Help.

Exporting Presentations to Word

Users can insert PowerPoint information into a Word document in several ways. For example, they can easily copy and paste text or graphics. To send a presentation to Word to modify, print, or distribute, users can export meeting minutes, action items, or the outline of a PowerPoint presentation.

Exporting Information from Meeting Minder to Word

By using Meeting Minder, users can take meeting minutes or record action items while a slide show is being presented. To format, edit, and print meeting minutes and action items, users can export them to a Word document. Word places all the meeting minutes and action items for the presentation in a single document. To export meeting minutes and action items, users can click Export to Word in the Meeting Minder dialog box (Tools menu, Meeting Minder command). PowerPoint starts Word, creates a new document based on the Normal template, and exports the meeting minutes and action items to the new document.

Exporting a Presentation Outline to Word

Users can export the outline of a PowerPoint presentation so that it can be edited in Word by pointing to Send To on the File menu and then clicking Microsoft Word.
Adding Embedded Objects to PowerPoint Presentations

Users can add information created in another Office application to a presentation by embedding the information as an object. For example, a user can add a table created in Word or a chart created in Excel to a slide by embedding the table or chart. After an object is embedded, it can still be edited in the application in which it was created. When the user double-clicks an embedded object in PowerPoint, the application that created the object opens, allowing the user to edit the file. For information about using embedded objects to share information between Office applications, see Microsoft PowerPoint Help.

Importing Data to Entourage X

If your organization is switching to Microsoft Entourage X for Mac from a different e-mail application or personal information manager (PIM), users can import information that they created in other applications, including contacts, calendar events, notes, tasks, messages, rules, signatures, and account information.

Importing Data from Another Application

Users can import information such as messages, contacts, calendar events, tasks, and rules directly from these applications:

- Microsoft Entourage 2001
- Microsoft Outlook® Express (5.0 or later)
- Qualcomm Eudora (any version)
- Netscape Communicator (versions 4.X only)
- Claris Emailer 2.0v3
- Now Contact (3.8 or later)
- Now Up-To-Date (3.8 or later)
- Claris Organizer 2.0

To import data to Entourage X, users can click Import on the File menu and then follow the instructions in the Import Assistant.
Users can continue to use their previous e-mail application or PIM even after importing data to Entourage. If users plan to use only Entourage to send and receive messages and manage their personal information, they can remove their previous application from their computers. However, users should make sure that all their data has been successfully imported to Entourage before removing the previous application.

For information about special considerations for importing data from specific applications, see the following sections.

**Importing Data from Microsoft Entourage 2001**

Custom Views that filter on more than one area will be imported into the new Custom Views area of Entourage X. Custom Views that filter on only one area (Mail, Address Book, Calendar, and so on) will be imported into the Custom Views section of that area. Also, folder synchronization settings for schedules that receive messages from IMAP and Hotmail accounts are not imported. The user must reenter folder synchronization settings for such schedules.

**Importing Data from Microsoft Outlook Express 5**

If the user selected default fonts for displaying, creating, or printing items in Outlook Express — if they selected the default font for messages in HTML format, for example — the user must restart Entourage after the import process is complete to update these settings in Entourage.

If the user selected an AppleScript script to run as part of a rule, schedule, or action by the Junk Mail Filter in Outlook Express, the script will need to be updated to work with Entourage. This can be as simple as opening the script in the Script Editor and replacing "Outlook Express" with "Microsoft Entourage" in any "tell application" statements in the script. After the script has been updated, the user must open the rule, schedule, or Junk Mail Filter in Entourage, and then select the updated script.

**Importing Data from Microsoft Outlook Express 4.5**

Entourage X does not support importing data directly from Outlook Express 4.5 or earlier. To import this data, first upgrade to Outlook Express 5 and then import the data from Outlook Express 5 to Entourage.
Importing Data from Apple Mail

Entourage X does not support importing data directly from Apple Mail. However, an AppleScript script for importing messages in Apple Mail Personal Mailboxes to Entourage is available in the Value Pack on the Microsoft Office v. X CD-ROM. For more information on this script, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD.

Importing Data from Qualcomm Eudora (Any Version)

Because Entourage X does not import the status of messages (whether they are read or unread), the status of all imported messages will be marked as unread in Entourage. After the message import process has finished, the user can quickly mark all of their messages as read. To do so, the user can click the imported folder in the Folders list, and then click **Mark All as Read** on the **Message** menu. Additionally, Entourage does not maintain links between imported messages and their attachments, but the attachments are stored in the Users/username/Documents/Microsoft User Data/Saved Attachments folder.

Importing Data from Netscape Communicator 4.X

During the import process, when the user is asked to select the Netscape Users folder that contains the data they want to import, make sure they select the folder that contains their profile folder (the Netscape Users folder), not the profile folder itself. If the user has stored his or her profile folder in a different location — for example, in the user's Documents folder — select that folder instead.

Importing Data from Claris Emailer 2.0v3

When users import data from Claris Emailer, Microsoft Entourage automatically starts Emailer; Emailer must be running for Entourage to import data from it.

If users have problems importing data from Claris Emailer, try assigning more memory to Emailer by using the Get Info dialog box in the Finder. For more information about assigning more memory to a program, see Mac OS Help in the Classic environment. After you have assigned more memory to Emailer, start both Emailer and Entourage, and then begin the import process again.

Because account settings, priorities, rules, mail actions, and schedules cannot be imported from Claris Emailer, users will need to re-create these items in Entourage. Additionally, Entourage does not maintain links between imported messages and their attachments, but the attachments are stored in the Users/username/Documents/Microsoft User Data/Saved Attachments folder.
Importing Data from Claris Organizer 2.0

Entourage always imports the Primary address from the former program into the Work address tab in Entourage. If users have changed the labels so that the Primary address is "Home" and the Secondary address is "Work," they will need to swap addresses for their contacts. For tools and information that will help them with this process, visit the Microsoft Entourage Value-Add Scripts page on the Mactopia Downloads Web site at http://www.microsoft.com/mac/download/office2001/EntScripts.asp.

Importing Data from Now Contact or Now Up-To-Date 3.8 or Later

When users import data from Now Contact or Now Up-To-Date, Entourage X automatically starts Contact or Up-To-Date and opens the default data file for the program. However, in some cases users should manually start Contact or Up-To-Date and open the data file that contains the data they want to import before they start the import process in Entourage. Start the program manually if:

- The user has created more than one data file for Contact or Up-To-Date.
- The user tries to import data and the import stalls, alerts the user of an AppleEvent timeout, or does not import any data.

Similarly, if users are using a trial version of Now Contact or Now Up-To-Date, be sure they manually start the program and, before they start the import process in Entourage, dismiss the initial dialog box that prompts them to register the program.

Because categories cannot be imported from Now Contact and Now Up-To-Date, users will need to re-create their categories in Entourage. To do so, users can point to Categories on the Edit menu, and then click Edit Categories. Also, some types of attachments for contacts — calls, appointments, to-dos, undated and special events, holidays, URLs, and documents, for example — and events — contacts and URLs, for example — cannot be imported.

Importing Data from Other Programs, such as Microsoft Outlook 2000

Users can directly import data only from the programs listed above. However, users can import contacts and messages from other programs by first exporting the contacts or messages from the other program in a format that Entourage understands, and then importing them to Entourage. For example, users can export contacts from Microsoft Outlook 2000 as a tab-delimited text file and then import the file to Entourage. For more information about exporting data from a specific program, see the documentation for the program.
Importing Data from a Text File

If your organization is switching to Entourage from an application that is not listed above, users can also import the following types of data from a text file:

- **Contacts** A user can import contact information from a text file that was exported from any application, including spreadsheet and database programs. The text file must be exported in tab-delimited or comma-delimited format. For more information about exporting contacts to a text file, see the documentation for the source application.

  Before importing the contact information, the user can specify how data fields in the source application correspond to fields in Entourage. For example, if the source application contains a field called Business Phone, the user can specify that the data in that field is imported to a work phone field in Entourage. For more information about importing contacts from a text file, see Microsoft Entourage Help.

- **Messages** A user can import messages that have been saved as an MBOX-format text file, a format commonly used by UNIX-based systems. An MBOX-format text file is a single file that can contain many messages. When the user imports an MBOX-format text file to Entourage, the imported messages appear in a new folder in the Folder list. Users can quickly import an MBOX-format text file by dragging the file from the Finder to the Entourage Folder list.

You can also use the Entourage text importing features to provide standard data to all of your users. For example, you can create a tab-delimited or comma-delimited text file that contains contact information for members of your organization and distribute it when you deploy Office v. X.

**Note** To maintain a centrally located address book for your organization, you can store a contact database in an LDAP directory on a server. To access the LDAP directory, each user can create a directory service account in Entourage. For information about directory services and setting up an account in Entourage, see Microsoft Entourage Help.

Handheld Synchronization

Entourage 2001 included the Handheld Synchronization component that allowed Entourage users to synchronize contacts, tasks, notes, and calendar events with any Palm handheld that uses Palm OS 2.0 or later, including Handspring Visor.

No such component is included with Entourage X. However, information about directly synchronizing Entourage with a handheld will be posted on the Mactopia Web site as soon as it is available. For information and updates, visit the Handheld Synchronization page on the Mactopia Web site at http://www.microsoft.com/mac/entourage/palm/default.asp.
International Features of Office v. X

Microsoft® Office v. X for Mac programs support editing and viewing of documents in many languages. If your users work with documents that contain text in more than one language or if users share documents with people who use Office on systems that run in other languages, you or your users can customize Office v. X to manage conventions and requirements unique to each language.

Each of the applications in the English version of Microsoft Office v. X for Mac has features that enable users to create, view, and edit documents in languages other than English.

Office v. X Shared International Features

Mixed character support  Office v. X applications can accommodate multiple international character sets within the same section of text. For example, a single Word X document can include English, French, and — when registered by using Microsoft Language Register — Japanese characters.

International proofing tools  International proofing tools for each of the supported languages can be installed from the Value Pack. The proofing tools for European languages allow Office to hyphenate according to the rules of the language and check the spelling of text. The proofing tools also include a thesaurus for each language, and a German grammar checker. British, Australian, and U.S. English proofing tools are included in the English version of Office v. X. The Japanese proofing tool component included in the Value Pack with non-Japanese versions of Office v. X provides Japanese rules for full grammar and consistency checking.

Multilingual Web pages  Users of Word, Excel, and PowerPoint® can set the default character set encoding when they save documents as Web pages (File menu, Save As Web Page command, Web Options dialog box, Encoding tab).

Sorting rules for multiple languages  Office v. X applications sort data in tables and lists according to the rules of the currently selected language in Mac OS X, which is selected by using the International pane in System Preferences (Apple menu). This includes Japanese when the application is registered for using Japanese characters by using the Microsoft Language Register.

Correct date, time, and number style  When you enter dates, times, and numbers, Office v. X applications can format them in the correct style for different languages. Office v. X supports international date and time formats.
**Euro support**  All Office v. X applications offer full support for entering, displaying, and printing euro currency values. Excel X provides support for performing financial calculations involving the euro.

**German post-reform spelling rules**  Users can set Microsoft Word, PowerPoint, and Entourage X to set an option in Preferences to use German post-reform spelling rules when checking the spelling of German text.

---

**International Features of Entourage X**

- **Japanese contact format**  By using Japanese contact format, users can enter furigana for contact information such as a contact's first, last, and company names. Users can also keep track of greeting cards they have sent to or received from a contact according to year. In addition, Japanese contact format changes the order of some name and address fields and removes others, such as the **Postal code** field, so users can enter and store Japanese addresses correctly.

- **Lucky days**  The Entourage Calendar can display lucky days. Users can choose between displaying specific lucky days or all lucky days.

- **Support for Japanese text**  By using an input method editor (IME), users can type Japanese text in messages, tasks, and other items. This feature is available if you use the **International** pane in **System Preferences** (**Apple** menu) to turn on the Japanese keyboard layout and set the Mac OS to Japanese. Users can also enable this feature by registering Entourage with the **Microsoft Language Register** tool for use with the Japanese language.

---

**International Features of Word X**

When Japanese language support is enabled users can edit text as follows. You may need to install the Microsoft Proofing Tools from the Value Pack to use some features.

- Check spelling and grammar according to the rules of another language.
- Look up words in the thesaurus of another language.
- Hyphenate text in another language.
- Automatically correct text typed in another language.

**Formatting options for Japanese text**  Special commands on the **Format** menu allow users to fit text to a specified width, set phonetic guides and enclose characters, combine characters to mix horizontal and vertical text in one line, and quickly switch between displaying hiragana and katakana characters as well as between half-width and full-width characters. Additional AutoFormat options for Japanese text allow users to automatically insert closings in memos and other documents. Options in the **Font** dialog box (**Format** menu, **Font** command) to specify separate fonts for Asian and Latin text and set emphasis marks.
Searching for Japanese text  When finding and replacing text, Japanese find options (Word menu, Preferences command, Japanese Find) allow users to find text that sounds similar and to set specific character matching options. Users can also set options to broaden or narrow the search for text in a document by treating some punctuation characters as identical.

Setting display options for Japanese text  Users can use Japanese Typography (Word menu, Preferences command) settings to set Japanese typography options for kerning and character spacing, prevent certain characters from appearing at the start or end of lines of text, and set options for line breaks.

Setting layout options for Japanese text  The Japanese Document Grid (Format menu, Document command, Document Grid tab) gives users control to specify whether to use a line grid or line and character grid to control formatting and what measurements are used for the grid so that they can enter characters by using fixed-pitch spacing (as in Genko or Gaozhi formatting). Users can also use the Document Grid to set gutter at left or top of document (default is left) and set the document to print two full-scale pages on one sheet of paper to make booklets. Options on the Indents and Spacing tab (Format menu, Paragraph command) allow users to automatically adjust right indent to fit the document grid and snap paragraphs to the grid as well as set the paragraph alignment to distribute text.

International Features of Excel X

Add phonetic guides  Users can add phonetic guides to Japanese data that has been entered in a cell. The phonetic character string that was used to enter the Japanese data is used to apply phonetic guides. To display the phonetic guides on the screen, point to Phonetic Guide on the Format menu, and then click Show Phonetic Fields.

Modify phonetic guides  If the displayed phonetic guides are incorrect, users can revise them. Select the cell that shows the incorrect phonetic guides. On the Format menu, point to Phonetic Guide, and then click Edit. Users can now change the phonetic guides by using the same method they use to enter a character string.

Change phonetic guide formats  Users can change the type, alignment, and font of phonetic guides. The three types of phonetic guides available are hiragana, full-width katakana, and half-width katakana. Their default alignment is left alignment (that is, placed along the left edge of the kanji to which the phonetic guides apply). Users can change the alignment to no alignment (all phonetic guides are combined and aligned along the left edge of the cell), center alignment (centered against the kanji to which the guides apply), or distributed alignment (set with equal spacing against both edges of the kanji to which the guides apply). To change the type, alignment, or font of phonetic guides, point to Phonetic Guide on the Format menu, and then click Settings.
Sort data by using phonetics  When worksheet data is sorted, Japanese data is sorted by its phonetic guides by default. If the correct phonetic guides have been used on characters that use them, Japanese terms are sorted in the same order as they would occur in a Japanese dictionary. If the phonetic guides are not entered correctly, make the necessary corrections.

Automatic currency selection  Currency formats use the yen as the default monetary unit when an Office application is registered with the Microsoft Language Register tool for use with the Japanese language.

Language-specific Custom Lists  Excel provides custom lists appropriate to each of the supported languages. For example, lists of the names of the days of the week and of the months are determined by the language settings in Mac OS X system preferences. To choose a set of custom lists for a particular region, users must choose the corresponding date and number formats on the International preference pane in System Preferences (Apple menu).

Euro Conversion in Excel X  Like all Office v. X applications, Excel enables users to enter, display, and print the euro symbol. Excel X also provides extensive support for financial calculations involving euro values through the Euro Currency Tool add-in (Tools menu, Add-ins command). The Excel X Formatting toolbar also includes a Euro Style button for formatting cells in euro currency style.

The Euro Currency Tool add-in provides the EUROCONVERT function, which can convert a number to euros, convert from euros to a euro member currency, or convert from one member currency to another by using the euro as an intermediary. The currencies available for conversion are those of European Union members that have adopted the euro. The EUROCONVERT function uses fixed conversion rates that are established by the European Union.
The EUROCONVERT function supports the following euro member countries and currencies:

<table>
<thead>
<tr>
<th>Country</th>
<th>Unit of currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belgium</td>
<td>franc</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>franc</td>
</tr>
<tr>
<td>Germany</td>
<td>deutsche mark</td>
</tr>
<tr>
<td>Spain</td>
<td>peseta</td>
</tr>
<tr>
<td>France</td>
<td>franc</td>
</tr>
<tr>
<td>Ireland</td>
<td>pound</td>
</tr>
<tr>
<td>Italy</td>
<td>lira</td>
</tr>
<tr>
<td>Netherlands</td>
<td>guilder</td>
</tr>
<tr>
<td>Austria</td>
<td>schilling</td>
</tr>
<tr>
<td>Portugal</td>
<td>escudo</td>
</tr>
<tr>
<td>Finland</td>
<td>markka</td>
</tr>
</tbody>
</table>

For more information about euro currency conversion in Excel, see Microsoft Excel Help.
Configuring Office v. X for Multiple Languages

To enable support for international features in the English version of Microsoft Office v. X for Mac, users must configure their computers to recognize the language they want to use, and the proofing tools for the language must be installed.

Languages Supported by Office v. X

Users of English versions of the Mac OS can use the multiple-language features of Microsoft Office v. X for Mac to display and edit documents in English and other languages. Office v. X supports the following languages:

- Japanese
- Danish
- Dutch
- French
- German
- Italian
- Spanish
- Swedish

Notes

- Office v. X supports Australian, British, and Canadian keyboard layouts, in addition to keyboard layouts for languages other than English.
- Installing Office v. X on a version of the Mac OS for any of the supported languages except Japanese also enables the multiple-language features of Office v. X.
Enabling Japanese Language Features

Japanese language support is available for users of the English language version of Office v. X when the Microsoft Language Register tool is used to register the applications for use with the Japanese language.

By using the Microsoft Language Register tool, users can enable Japanese features in a number of Office v. X applications. After installing the Microsoft Language Register tool from the Value Pack, users can enable Japanese features by dragging a specific Office program file to the Microsoft Language Register file, located in the Microsoft Office X/Utilities folder. They should then follow the instructions in the dialog box that appears. To enable Japanese features completely, users must register the following Microsoft Office programs: Excel, Word, Entourage, PowerPoint, Graph, Organization Chart, Clip Gallery, Equation Editor, and Office Notifications.

For information about installing the Microsoft Language Register tool from the Value Pack, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.

Enabling European Language Features

European language support is available when one or more keyboard layouts for supported European languages is enabled on the Keyboard Menu tab on the International pane in System Preferences (Apple menu, System Preferences command). To switch between languages, users can select the appropriate keyboard layout. For more information about setting a keyboard layout, see Mac Help.

European language features in the English version of Office v. X can also be enabled by installing Office v. X on a version of the Mac OS for a supported language on page 98.

Installing International Proofing Tools

Proofing tools for the supported languages can be installed by using the Value Pack Installer application on the Microsoft Office v. X CD-ROM. For more information about installing Value Pack components, see the Guide to the Value Pack in the Value Pack folder on the Office v. X CD-ROM.
Toolbox

The Toolbox contains a set of tools and documents designed to help you deploy, configure, and support Microsoft® Office v. X for Mac. To use any of these tools, click the appropriate link, and then download and open the corresponding file on your computer.

Tip For additional tools that can help you deploy, configure, and support Office v. X, visit the Mactopia Downloads center.

Deployment Folder Calculator

Calculator_X.xls File size: 98 KB

A Microsoft Excel workbook that helps you calculate the total amount of disk space required for an Office v. X deployment folder. You specify the components that you want to include, and the workbook calculates the total amount of disk space required.

Files Installed by Office v. X

FileList_X.xls File size: 183 KB

A Microsoft Excel workbook that lists the files that are installed by Office v. X. The workbook also identifies the folder where each file is installed and the location of each source file on the Microsoft Office v. X CD-ROM.

Files Available from the Value Pack

VPFileList_X.xls File size: 1,054 KB

A Microsoft Excel workbook that lists the files that are available from the Value Pack. The workbook also identifies the folder where each file should be installed and the location of each source file on the Microsoft Office v. X CD-ROM.
Glossary

A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z

A

add-in
Software that extends an application by adding functionality that is not in the main application.

AppleTalk network integration
A software component of Microsoft® Windows® 2000 Server or later that allows Macintosh users to access computers running Windows 2000 Server or later. The services provided with this component allow Macintosh and Windows users to share files and resources, such as printers on the AppleTalk network or printers attached to the computer that is running Windows 2000 Server or later.

C

client computer
A computer that accesses shared network resources that are provided by a server computer. See also server.

copy mode
In Microsoft® Excel, the mode in which copied cells can be pasted. In copy mode, cells that have been copied to the clipboard are outlined with a moving dashed line.

D

deployment folder
The folder that is created when Microsoft® Office v. X for Mac is initially installed on one computer for later distribution to other computers.
**drag-and-drop installation**

A method of installing a Microsoft® Office v. X for Mac application by dragging the application folder to the hard disk of the target computer.

**E**

**embedding**

A method of inserting an object, such as a document or worksheet, into a file (the destination file). After the object is embedded, the object becomes part of the destination file. When a user double-clicks an embedded object, the object opens in the program it was created in. Any changes the user makes to the embedded object are reflected only in the destination file. *See also* [linking](#).

**Extended UNIX Code (EUC)**

A character encoding scheme that uses 2 bytes to represent each character. EUC can be used to represent extended character sets.

**F**

**furigana**

The phonetic spelling of a Japanese word or name.

**I**

**iCalendar**

An abbreviation for Internet calendaring, a standard for sending invitations over the Internet.

**identities**

A feature of Microsoft® Entourage™ X for Mac and Microsoft Office v. X for Mac that allows multiple users to share a single computer by storing their personal e-mail, Calendar, tasks, and other information separately.

**Internet Message Access Protocol (IMAP)**

A protocol for receiving and accessing messages from a server. Because messages are stored on the server instead of locally, users must be connected to the mail server when they read messages. *See also* [Post Office Protocol (POP)](#).
K

Kerning
A method of adjusting text by slightly decreasing or increasing the amount of space between any two adjacent letters.

L

Lightweight Directory Access Protocol (LDAP)
A protocol for storing information such as a list of contacts. LDAP directories are searchable and can store data for several thousand individuals.

Linking
A method of inserting an object, such as a document or worksheet, into a file (the destination file) while maintaining a connection between the object's source file and the destination file. The linked object in the destination file is updated automatically when the source file is updated. See also embedding.

M

MBOX
A standard format for storing multiple e-mail messages in a text file. A single MBOX-format text file can contain many messages. The MBOX format is most commonly used on UNIX systems.

Me contact
The contact in the Address Book that contains personal information about the user. In the Address Book list, the Me contact has next to it.

N

Narration
In Microsoft® PowerPoint®, a sound file that plays along with a presentation. Narration can be embedded in or linked to a presentation. See also embedding, linking.
Navigation Services dialog box
A file system dialog box that is provided by the Macintosh operating system and that provides access to Recent and Favorites file lists.

network installation point
The network folder from which users install Microsoft® Office v. X for Mac. A network installation point can be created by placing an Office v. X deployment folder in a network folder and making the network folder available to users. See also deployment folder.

Network News Transfer Protocol (NNTP)
A protocol for sending and receiving news messages over the Internet.

Normal template
The Microsoft® Word template on which all Word documents are based.

Post Office Protocol (POP)
A protocol for receiving messages from a server and for downloading those messages to a client computer. Because messages are stored on the client computer, users can read messages without being connected to the server. See also Internet Message Access Protocol (IMAP).

privilege level
A rule that is associated with an object, such as a file or folder, and that regulates which users can access the object and what level of access, such as read-only or read/write, users have.

roundtrip
The conversion of a file from one format to another and then back to the original format.
Runtime Installation (RI)
The process of installing additional Office fonts (if necessary) and checking for a valid product ID that occurs when a Microsoft® Office v. X for Mac application is started.

Secure Sockets Layer (SSL)
A protocol for ensuring security and privacy in Internet communications. SSL supports authentication of the client, the server, or both, as well as encryption during a communications session.

server
A computer that provides shared services, such as file storage, file transfer, message transfer, and database queries, to network users on client computers. See also client computer.

Simple Mail Transfer Protocol (SMTP)
A TCP/IP protocol for sending e-mail messages from a computer to a server and from one server to another.

Unicode
A standard character encoding scheme that uses 2 bytes to represent each character, which allows more than 65,000 characters to be represented.

vCard
A standard for creating electronic business cards and sharing contact information over the Internet. Contacts in vCard format have a .vcf file name extension.

virtual memory
Temporary storage that is used by a computer to run programs that need more memory than the computer has. For example, programs could have access to 4 GB of virtual memory on a computer's hard drive, even if the computer has only 32 MB of RAM.
**W**

**WordBasic**

A programming language that is used for writing macros in Microsoft® Word 95 and earlier versions. Microsoft Visual Basic® for Applications replaces WordBasic in later versions of Word.
Index

A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z

A

action settings 69

add-ins

in Excel 17
in Word 17
installing custom 49

Address Book 84

AppleScript

in Entourage 34
in Excel 24
in Word 18

AppleWorks

converting to Excel 58
converting to Word 52
new converters 9

Assistant, See Office Assistant 111

AutoRecover 10

B

Based on Recent 8

C

Calendar 32

changes (tracking)

in Excel 77
in Word 71

Claris applications 88

Clear Formatting 9

Clipboard 8

comments

in Excel 77
in PowerPoint 83
in Word 71

complete installation, See standard installation 113

Contact toolbar 9

contacts

importing 92
sharing 84

custom installation 47

D

Danish 98

Data Merge 9
database in Entourage 28
  backing up 29
  compacting 29
  damage symptoms 30
  rebuilding 30
  rebuilding, advanced 30

dBase 58

default file formats
  in Excel 19
  in Word 13

default file locations 19

deploying 42
  See also installing 110
  calculating disk space 100
  configuring preferences 48
  over network 45
  over network, requirements 42
  preferences 48
  Value Pack components 50

deployment folder calculator 100

drag-and-drop installation 43

dual file format 60

Dutch 98

E

Easy Install, See standard installation 113

e-mail
  Excel workbooks 79
  PowerPoint presentations 82
  setting up presentations 25
  Word documents 73

embedding
  Excel workbooks in Word 83
  objects in PowerPoint 88

encryption
  in Excel 80
  in Word 74

Entourage 25
  AppleScript 34
  configuring 25
  database 28
  default setup folder 25
  Exchange Server with identities 32
  importing data 88
  known issues 41
  mail accounts 25
  Main Identity folder 28
  Me contact 28
  multiple users 28
  new and updated features 11
  proxy servers 25
  secure mail accounts 25
  setup information 25

euro 93
HTML
converting Excel data to  65
converting to Word  52
converting Word documents to  64
PowerPoint features for  68
Word features for  63

I
identities  28
installing  42
See also deploying  108
custom installation  47
drag-and-drop  43
Easy Install  46
on client computers  45
standard installation  46
Value Pack components  50
with Installer application  43

international features  93

Internet Explorer  68
Italian  98

Japanese  98

K
keyboard layout  98
keyboard shortcuts  10
Keychain  11

known issues
in Entourage  41
in Excel  37
in PowerPoint  39
in Word  34

L
Language Register  99
languages
European  93
Japanese  93
multiple language support  93
licenses  12
Lotus 1-2-3  58

M
Mac OS Keychain  11
macros
digitally signed  74
earlier Excel versions  56
earlier Word versions  51
locations in Word  15
translating  56
WordBasic  51

mail accounts  25
Main Identity  28
MBOX text file  92

menus
customizing in Excel  20
customizing in Word  16
locations in Word  15
Microsoft Entourage, See Entourage 108

Microsoft Excel, See Excel 109

Microsoft Language Register 99

Microsoft Office Settings (10)
   Excel preferences in 18
   PowerPoint preferences in 24
   Word preferences in 12

Microsoft PowerPoint, See PowerPoint 112

Microsoft User Data folder 25

Microsoft Word, See Word 114

Microsoft Works, See Works 114

Movies (PowerPoint) 11

multilingual 93

multiple users
   setting up 28
   through Mac OS 8

Multi-selection 9

N

Netscape Communicator 88

Netscape Navigator 68

network installation point
   deploying from 45
   requirements for 42

new and updated features 8
   in Entourage 11
   in Excel 10
   in PowerPoint 11
   in Word 9
   shared 8

Now applications 88

O

ODBC 85

Office Assistant 8

Office Clipboard 8

operating system 44

options, See preferences 112

Outlook Express 88

P

Packages (PowerPoint) 11

Palm handheld computers 92

passwords
   encrypting 25
   in Excel 80
   in Word 74
<table>
<thead>
<tr>
<th><strong>PowerPoint</strong></th>
<th>processors</th>
<th>44</th>
</tr>
</thead>
<tbody>
<tr>
<td>action settings</td>
<td>69</td>
<td></td>
</tr>
<tr>
<td>comments in</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>configuring</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>embedding objects</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>exporting to Word</td>
<td>87</td>
<td></td>
</tr>
<tr>
<td>file formats</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>hyperlinks in</td>
<td>69</td>
<td></td>
</tr>
<tr>
<td>known issues</td>
<td>39</td>
<td></td>
</tr>
<tr>
<td>Movies</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>new and updated features</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>outlines in Word</td>
<td>84</td>
<td></td>
</tr>
<tr>
<td>Packages</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>presentations</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>setting preferences in</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>sharing presentations</td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>slides</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>templates</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>viewer</td>
<td>63</td>
<td></td>
</tr>
<tr>
<td>Web features</td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>workgroup features</td>
<td>82</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>PowerPoint Settings (10)</strong></th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>preferences</td>
<td>48</td>
</tr>
<tr>
<td>in Excel</td>
<td>18</td>
</tr>
<tr>
<td>in PowerPoint</td>
<td>24</td>
</tr>
<tr>
<td>in Word</td>
<td>12</td>
</tr>
</tbody>
</table>

| presentations | 24 |
| comments in | 83 |
| hyperlinks in | 69 |
| saving as Web pages | 68 |

<table>
<thead>
<tr>
<th>printing</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>in Entourage</td>
<td>41</td>
<td></td>
</tr>
<tr>
<td>in Excel</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>in Word</td>
<td>34</td>
<td></td>
</tr>
<tr>
<td>new features</td>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

| **Project Gallery** | 8 |
| protocols |  |
| of e-mail servers | 25 |
| supported by Exchange Server | 32 |

| **proxy servers** | 25 |
| **Q** |  |
| Qualcomm Eudora | 88 |

| **QuickTime** | 11 |
| **R** |  |
| REALbasic | 8 |

| rebuilding Entourage database | 30 |
| requirements | 44 |
| for client computers | 44 |
| for servers | 42 |

| revision marks |  |
| in Excel | 75 |
| in Word | 71 |

| **Rich Text Format** | 54 |
| **Runtime Installation** | 47 |

| **S** |  |
| scheduling | 32 |

| security features |  |
| in Entourage | 25 |
| in Excel | 80 |
| in Word | 74 |
servers
  deploying from 45
  requirements for 42

shortcut keys 10

slide masters 11

Slide Navigator 11

SMTP authentication 25

Spanish 98

SSL 25

standard installation 46

startup folders
  in Excel 19
  in Word 14

Swedish 98

system requirements 44

T

templates
  custom 49
  Excel 20
  PowerPoint 24
  Word 14

text files
  importing to Entourage 92
  importing to Excel 86

toolbars
  customizing in Excel 20
  customizing in PowerPoint 39
  customizing in Word 16
  locations in Word 15

Toolbox 100

tracking changes
  in Excel 77
  in Word 71

U

updated features, See new and updated features 111

V

Value Pack 50

Value Pack Installer 43

volume licensing 12

W

Web pages
  converting to Word 52
  PowerPoint features for 68
  saving Excel data as 65
  saving PowerPoint files as 63
  templates in Word 64
  Word features for 63

Web queries 86